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Introduction
Blueprint is a powerful requirements solution that allows users to collaboratively author, validate, and manage
requirements. This guide is intended for end users of the Blueprint product. New users will want to begin with the
Blueprint Getting Started Guide. Blueprint instance administrators and project administrators can refer to the
Instance Administration Guide and Project Administration Guide to learn how to administer the system.

About the utility panel

Overview
The utility panel is located on the right side of the Blueprint user interface. The utility panel allows you to view
detailed information about an artifact such as properties, comments, files, traces, and history. You can also use the
utility panel to access review information.

The utility panel looks like this:

A label is displayed at the top of every tab in the utility panel. It provides the ID and name of the artifact or sub-
artifact you are viewing. For example:
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Resizing and expanding/collapsing the utility panel

You can resize the utility panel by pointing to the vertical border. When the double arrow cursor appears, click
and drag the panel border to the left and right to increase or reduce the width of the panel. You can also expand
and collapse the utility panel using the expand and collapse buttons.

Tip: To make more space available to view your artifact(s), you can collapse both the utility panel and the
explorer panel by clicking the full screen button (the lower rightmost corner of the window).

Understanding the utility panel tabs

There are 8 tabs located in the utility panel. Each tab provides you with the ability to view different information
about the artifact.

Icon Tab Name Description

Properties The properties tab allows you to view and
change artifact properties.

Comments The Discussions tab allows you to view
comments, create new comments, reply to
existing comments, and change the status of
discussons.

Files The files tab allows you to view, add, and
delete artifact file attachments and document
references.

Relationships The Relationships tab in the utility panel allows
you to view and add artifact traces, effectively
establishing relationships with other artifacts.

Outline The outline tab provides you with an outline
view of the artifact. The outline view of an
artifact shows the parent-child relationships of
a diagram. The outline view presents the
artifacts and sub-artifacts in a tree-view style,
making it quick and easy to navigate diagrams.

Search The browse tab allows you to browse and
search for all types of artifacts.

History The history tab allows you to view previous
versions of the artifact and compare changes
between them.

Reviews The reviews tab provides you with a list of all
reviews that contain the artifact.
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About artifact properties
An artifact property refers to the descriptive data that is associated with an artifact or sub-artifact. All artifacts and
sub-artifacts have default system properties. These default system properties vary depending on the type of artifact
or sub-artifact. Artifacts and sub-artifacts can also have custom properties, which are configured by the project
administrators.

The properties tab allows you to view every property that is associated with an artifact or sub-artifact. The
properties tab on the utility panel looks like this:

Understanding the properties tab in the utility panel

A label is displayed at the top of every tab in the utility panel. It provides the ID and name of the artifact or sub-
artifact you are viewing. For example:

The property tab displays all associated properties, including both default system properties and any custom
properties that have been configured by the project administrator. You can expand and collapse the headings
(example: Properties, Description) to show or hide the information.

Viewing and changing artifact and sub-artifact properties

To view the properties of an artifact, simply open the artifact and click the properties tab in the utility panel. If
you want to view the properties of a sub-artifact, you must open the artifact that contains the sub-artifact, and then
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select the sub-artifact. For example, if you want to view the properties of a shape in a diagram, you must open the
diagram and click the shape (sub-artifact) to view the properties.

Changing the value of a property is as simple as changing the information that appears in the properties tab. Some
properties, such as the ID, cannot be modified.

Note: You must publish the artifact before your changes are viewable by other users.

Performing a bulk update 
The bulk update feature allows you to update your artifacts more efficiently. When you have an update you need
to apply across multiple artifacts, bulk update lets you apply the change with one simplified action. You can bulk
update up to 5000 artifacts.

In the main content area, simply select the artifacts that you want to update and then click the Bulk Update button:

You can bulk update any of your artifacts's properties. Read-only artifacts are the only artifacts that cannot be
updated in bulk.

To perform a bulk update:

Important: If you undo a bulk update because the bulk update results do not meet your expectations, the
undo is not automatically published.

Tip: Before you do a bulk update, we recommend publishing or discarding any desired changes. If the
bulk update does not meet your expectations, you can discard all changes without losing work.

1. In the main content area, select the artifact(s) and/or folder(s) you want to change and then click Bulk
Update (Home tab).

The Bulk Update dialog box appears.

2. To update a property, select it from the Select property to bulk update menu and then click the Add
button.

The property appears below the menu.

To remove a property, click the red X next to the property field.



©2015 Blueprint Software Systems Inc. All rights reserved 15 of 183

Tip: By selecting the Apply changes to all children of the selected artifact(s) check box, you can
also update the child artifacts of the selected parent artifacts.

3. To update another property, perform the previous step again.
4. Make your changes in the fields that appears next to your properties.

Note: When the blue information icon appears next to a property you want to update, the
property is not shared by all of the artifacts you selected. The update will not apply to all of your
artifacts.

5. When you have made all of your changes, click Update.

If your update succeeded, your artifacts appear with lock icons in the main content area.

6. To apply the bulk update to your artifacts, click the Save All button or Publish All.

About rich text formatting
Blueprint provides you with the ability to create textual content using rich text formatting. In other words, you can
perform many of the operations that you can perform using a word processing application. The rich text formatting
features are available on the ribbon Home tab:

Here's a list of the rich text formatting features offered by Blueprint:

Change font type, color, and size
Make the font bold, italic, underline, subscript, superscript, strikethrough
Apply highlighting to font
Add a hyperlink
Create a bulleted or numbered list
Change the paragraph justification



©2015 Blueprint Software Systems Inc. All rights reserved 16 of 183

Rich Text Formatting in the Artifact List

Rich text formatting is displayed differently in the artifact list depending on the current mode. Here's an
explanation of the different modes and the way rich text formatting is displayed:

Edit in-place mode
all rich text formatting is displayed.

Non-edit and wrap text disabled:
text is displayed as plain text.

on hover, a tooltip displays a limited amount of rich text. Bullets and lists are not displayed in the
tooltip.
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Non-edit and wrap text enabled:
displays a limited amount of rich text. For example: Highlighting, bullets and lists are not displayed.

About rich text tables
In Blueprint, you can create tables in any artifact field that supports rich text formatting. For example:

Description fields
Custom properties that support rich text
Comment fields
Text areas of diagrams

When you create a table, the Layout and Styling tab appears on the ribbon with table styling options to choose
from.

To change the layout of your table, one or more table cells must be selected so that the Layout and Styling tab
appears with styling commands.

Copying and pasting rich text tables to and from other applications

Important: This feature is only available if Blueprint is configured to run with elevated in-trust browser.

To copy and paste rich text tables from Blueprint to other applications, and vice-versa, you need to have elevated
in-trust browser enabled (Profile Optionsmenu). For more information about enabling elevated trust-in browser,
see About elevated trust in-browser.

Copying tables from Blueprint and pasting in Microsoft Office documents

When you copy a table from Blueprint and paste in aMicrosoft Office program, like Word or Excel, any rich text
formatting in the table is preserved.
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Copying tables from Microsoft Office documents and pasting in Blueprint

When you copy a table from Microsoft Word or Excel and paste in Blueprint, any rich text formatting that is
supported in Blueprint is preserved.

For example, when you copy a table with bold header font from Microsoft Word and paste it in Blueprint, the
table's bold formatting is preserved (see image below). However, any font family in the Word table that is not
supported in Blueprint is not preserved when pasting into Blueprint.

Adjusting the height of a cell
You can customize cells to appear with specified heights or with an automatically selected height. The automatically
selected height adjusts the height so there is always enough room for the contents inside.

To change the height of a cell:

1. Select the cell for which you want to adjust the height.

2. Click the Height field (Layout and Styling tab, Cells group).

The cell height menu appears.

3. Select Auto if you want Blueprint to adjust the height automatically, or select px if you want to define the
height yourself.

4. In the Height field, specify the pixel height for your cell.
The new height of your cell appears in your table, affecting any cells within the same row.

Adjusting the width of a table
You can adjust the width of a cell, a table column, a table row or an entire table.

To adjust the width of an entire table or cell(s):

1. Select the cell(s), the table column or the table row you want to alter.

Example
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Selecting a table's rightmost column:

2. Click one of the followingWidth fields:

To change the width of an entire table: click after the number in the Width field in the Table group.

To change the width of one or more cell(s): click after the number in the Width field in the Cell group.

3. Choose a width format.

To choose the automatic width, click Auto.

To specify width in pixels, click px.

To specify width in percentage, click %.

4. Enter the new width in the Width field (Layout and Styling tab).

The cell(s) you have selected are resized to their new width.

Changing the border styling (color and weight) of a table or cell

Important: Border weight is only applied after selecting the border type. For example, if you select a
border weight of 3 pt, the change is not applied until after you click All Borders.

To change the border of a table or cell:

1. Select the cells containing the borders you want to change.

2. Select your border color.

Click Border Color and then click the new color of your border (Layout and Styling tab, Table Styling group).

3. Select your border weight.

Click the Borders button, selectWeight and then click the border weight you want (Layout and Styling tab,
Table Styling group).

Note: The changes are not applied until the next step.

4. From the Bordersmenu, select your border type.
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The border types you can choose from are specific to the sides of the border(s).

Your new border styling appears on your table or cell(s).

Deleting cells in a table
To delete cells:

1. Select one or more cell(s), columns or rows in a table.

Example

Selecting a table's rightmost column:

2. Click the Delete button and then click the corresponding command (Layout and Styling tab, Rows
& Columns group).

To delete the selected cell(s): click Delete Cells.

To delete selected column(s): click Delete Columns.

To delete selected row(s): click Delete Rows.

To delete the entire table: click Delete Table.

The cells you have selected have been deleted.

You can also right-click the cell, table, column or row you want to delete, and the following menu allows you to
click a corresponding command:
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Inserting a new row or column
To insert a new row or column:

1. Select a cell in the table.

2. Click one of the following buttons from the Layout tab (Rows & Columns group):

To insert a new row: click Insert Above or Insert Below.

To insert a new column: click Insert Left or Insert Right.

Your table now has the row or column you inserted.

Merging and splitting cells
Merging cells allows you to have a different cell structure on each row or column. After you perform amerge, you
can split the cells to restore the original cell structure.

Merging cells

You can merge two or more cells in a row or column into one cell.

To merge cells in a table:

1. Select the cells that you want to merge in your table.

Example

Selecting a table's rightmost column:
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2. Click the Merge Cells button (Layout and Styling tab,Merge group).

The selected cells merge into one cell.

Splitting cells to undo a merge

The Split Cells button allows you to conveniently undo a cell merge at any time.

To undo a cell merge:

1. Select the cell that you merged.

2. Click the Split Cells button (Layout and Styling tab,Merge group).
The cells are restored to their original structure, reversing the merge.

Keyboard shortcuts
Blueprint offers a number of keyboard shortcuts that allow you to perform various operations in Blueprint using
your keyboard instead of your mouse. This article outlines keyboard shortcuts for basic operations in Blueprint.

Many of the operations listed in the table below are also accessible as buttons on the Home tab (on the ribbon).

Keyboard shortcuts for basic operations

Keyboard Key(s) Operation Result / Effect

CTRL + X Cut You can apply the cut operation to text, images and most artifacts. For more
information about the cut operation's capabilities, see About copying and
pasting.

CTRL + C Copy You can apply copy to text, images and most artifacts. For more information
about copy's capabilities, see About copying and pasting.

CTRL + V Paste You can use the CTRL + V shortcut to paste text, images and most artifacts.
For more information about paste's capabilities, see About copying and pasting.
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Keyboard Key(s) Operation Result / Effect

ESC Exit
current
editing
operation

Equivalent to clicking the Cancel button (exiting edit mode). Can be used when
editing artifact menus or when editing artifact names in the main content area.

Here is an example of what happens when you select an artifact name within the
main content area and then press ESC:

DEL Delete Clears content.

F8 New
Artifact
right click
menu

When you select an artifact and then press F8 , the Create New Artifactmenu
appears. You can then click a command within the menu to add a new artifact or
edit the existing selected artifact.

F9 Save All Saves all changes.

CTRL + SPACEBAR Create
New
Artifact

Selecting an artifact and then pressing CTRL + SPACEBARcreates a new
sibling actor artifact.

Here is an example of a new artifact that is created (New Actor 7) after selecting
the Sign In artifact and then pressing CTRL + SPACEBAR:
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Keyboard Key(s) Operation Result / Effect

CTRL + SHIFT + W Manage
Traces

Within an open artifact, pressing CTRL + SHIFT + Wmakes the Traces dialog
box appear. You can then create, modify or delete a trace.

When selecting an artifact in a list, pressing CTRL + SHIFT + W makes the
Traces dialog box appear. You can then create, modify or delete a trace.

CTRL + SHIFT + 1 Opens
Keyboard
Shortcuts
pop-up

The Keyboard Shortcuts dialog box appears with a list of all of the Home tab
shortcuts mentioned in this table.

Viewing a list of shortcuts
To view a list of basic shortcuts within Blueprint, press CTRL + SHIFT + 1.
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Keyboard Navigation
Blueprint offers a number of keyboard navigation shortcuts that allow you to perform various operations in
Blueprint using your keyboard instead of your mouse.

Choice Drop-Down Keyboard Navigation

Keyboard
Key

Edit Mode Non-Edit Mode

Arrow
Keys

If the drop-down panel is open, arrow keys navigate within the drop-down
list panel until end is reached.

If the drop-down panel is not open, the arrow keys navigate the list without
opening the drop-down panel.

Navigates to next cell.

Tab /
SHIFT Tab

Navigates to next cell. Navigates to next cell.

Enter If valid, the Enter key commits changes and moves focus to the cell
below.

If not valid, the Enter key flags field with an inline error and moves focus
to the cell below.

Navigates to the cell
below.

Space Bar Opens the drop-down panel, allowing you to use the arrow keys to navigate
the drop-down.

Places cell in edit in
placemode.

Typing Takes you to the closest match. If a match cannot be found, you can simply
type in a new value.

Places cell in edit in
placemode.

ESC Cancels edit mode. N/A

Multi-Select Keyboard Navigation

Keyboard
Key

Edit Mode Non-Edit Mode Pop-Up Open

Arrow
Keys

Navigates to next cell. Navigates to next cell. Navigates between options in
the scrollable list.

Tab /
SHIFT Tab

Navigates to next cell. Navigates to next cell. Navigates the pop-up content
(left to right and top to
bottom).

Enter Navigates to the cell below. Navigates to the cell below. Accepts the value and closes
the pop-up.
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Keyboard
Key

Edit Mode Non-Edit Mode Pop-Up Open

Space Bar Opens the multi-select dialog.

After the dialog is closed, the
cell is shown in edit in place
mode.

Places cell in edit in placemode
and displays the multi-select list.

Selects/Deselects options in
the scrollable list.

Typing N/A N/A N/A

ESC N/A N/A Cancels edit mode.

Select Users Dialog Keyboard Navigation
The Select Users dialog is applicable for custom properties when the Type is set to User. The Select Users dialog
looks like this:

Here are some guidelines for navigating the Select Users dialog using your keyboard:

Keyboard
Key

Edit Mode Non-Edit Mode Pop-Up Open

Arrow
Keys

Navigates to next cell. Navigates to next cell. Navigates between
options in the scrollable
list.

Tab /
SHIFT Tab

Navigates to next cell. Navigates to next cell. Navigates pop-up content
(left to right and top to
bottom).

Enter Navigates to the cell below. Navigates to the cell
below.

Accepts the value and
closes the pop-up.

Space Bar Opens People Picker Dialog. After the
dialog is closed, the cell is shown in edit in
place mode.

Places cell in edit in place
mode and displays people
picker

Selects/Deselects options
in the scrollable list .

Typing N/A N/A N/A

ESC N/A N/A Cancels edit mode.
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Moving artifacts from one project to another project
All artifact types can be moved between projects in Blueprint with the exception of review artifacts and baseline
artifacts.

Data preservation differences between cross-project move and cross-project copy

Moving an artifact has a different effect from copying an artifact.

The following table shows which artifact data is moved and/or copied within a project compared to across projects:

Move Copy

In-Project Cross-Project In-Project Cross-Project

Trace relationships Preserved Preserved No No

Attachments Preserved Preserved Preserved Preserved

IDs Preserved Preserved No* No*

Comments Preserved Preserved No No

Custom properties Preserved Depends** Preserved Depends**

Document references Preserved Preserved No No

History Preserved Preserved No No
*For example, when you copy an artifact, the new copy of the artifact has a different ID from the original artifact.

**A custom property is only preserved when the destination project has the same custom property with the same
name and type.

When you move an artifact from one project to another project, the moved artifact is automatically saved but it is
not automatically published.

Undoing an artifact move

When you cut or copy an artifact from one project to another project, the Undo button is unavailable to undo the
action (that is, greyed-out).

To undo your artifact move, manually perform one of the following actions:

Select your artifact, press CTRL+X and then, to paste your artifact into its original folder, press CTRL+V
Select your artifact and then drag the artifact back to its original folder.

Moving an artifact from one project to another project

To move an artifact by dragging it from one project to another project:
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1. In your artifact list, select your artifact's first column (that is, the column to the left of the Name column).

2. Drag the artifact to the project you want to move it to in the Explorer area.

Your artifact and any of its related information (for example: ID and comments) now exist solely in the project you
have moved it into.

To move an artifact by cutting it from one project and pasting it into another project:

1. In your project, select the artifact you want to move and then press CTRL+X to cut the artifact.

A scissor icon appears next to your cut icon.

2. Place focus on the project or folder into which you want to paste the artifact. Press CTRL+V.

The artifact appears in your artifact list with a lock indicator. The artifact move is saved but not published. To
publish the move, click the Publish All button.

About copying and pasting

Copying and pasting text

In Blueprint, you can copy text from one artifact and paste it in another artifact. You can also copy text from one
project and paste it in another project.

Using the Ctrl-V keyboard shortcut to paste preserves any rich text formatting that your text has.

When you copy formatted text (bold, italics, and so on) and click the Paste button to paste it, you have the option of
pasting your text without formatting or keeping the formatting.
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Copying and pasting text examples

Example

Lewis, a business analyst, wants to copy bolded and green text from his UI mockup and paste it in
his textual requirement. All he has to do is copy the formatted text onto his Clipboard, select where
he wants to insert the text, and use the Ctrl-V keyboard shortcut.

Example

Susan, a business analyst, wants to copy information from her UI mockup and paste it in her textual
requirement. The information is bolded but she wants to paste the text without formatting. All she
has to do is copy the text onto her Clipboard, select where she wants to insert the text, click the
Paste button, and then click Paste Unformatted Text.

Pasting shapes

Blueprint shapes can be copied from one Blueprint artifact and pasted into other artifacts of the same type.
Blueprint shapes can be pasted in the same project or pasted into other projects.

Pasting Visio shapes

Important: This feature is only available if Blueprint is configured to run with elevated in-trust browser.

You can copy shapes from Microsoft Visio and paste the Visio shapes in Blueprint diagrams. When you copy a shape
from Visio and paste it in a Blueprint diagram, your Visio shape is inserted as an image. When you copy multiple
Visio shapes and paste them in a Blueprint diagram, your Visio shapes are inserted as an image.

Shapes can be copied from Microsoft Visio and pasted into the following artifact types:

UI mockups
Business process diagrams
Domain diagrams
Generic diagrams
Use case diagrams

Copying artifacts

Caution: When you copy and paste an artifact, trace relationships, IDs and comments are not preserved in
the new artifact.

With the exception of review artifacts and baseline artifacts, all artifact types can be copied from one project and
pasted in another project.

When an artifact has custom properties, the custom properties can only be copied and pasted into another project
when the destination project has the same custom properties.

In Blueprint, you can copy a folder from one project and paste it in another project.
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Pasting text in a diagram

To paste text within a diagram shape:

1. Copy the text onto your Clipboard using the Copy button or the Ctrl-V keyboard shortcut.

2. Open the artifact in Blueprint where you want to paste the text.

Click and drag a text-compatible shape onto the canvas, such as a text area or callout.

3. Click the shape to place focus on it.

4. When the text cursor appears on the shape, click the Paste button on the ribbon (Home tab, Clipboard
group) or use the Ctrl-V keyboard shortcut.

Tip: To paste the text without formatting, select the Paste button on the ribbon (Home tab, Clipboard
group) and then click Paste unformatted text.

About pasting images

Important: This feature is only available if Blueprint is configured to run with elevated in-trust browser.

With Blueprint, you can copy and paste images or screen captures from other applications into any Blueprint
artifact that supports images, including:

UI mockups
Use case diagrams
Generic diagrams
Domain diagrams
Business process diagrams

Maximum image size
You can paste images into Blueprint if the image size on the clipboard is 1900KB or less.

Note: When you copy an image to the clipboard, the image is copied to the clipboard in Bitmap format,
which is much larger than a JPG for instance. If the image is too large, you may want to consider using the
Image shape from the palette to add your shape to the diagram.

Pasting an image into Blueprint

To paste an image into Blueprint:

Note: You can copy and paste images that are up to 1900KB in size.

1. Copy the image onto your Clipboard.

2. Open the artifact in Blueprint where you want to paste the image. Click the canvas to place focus on the
canvas.
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3. Click the canvas to place focus on it.

4. Click the Paste button on the ribbon (Home tab, Clipboard group) or use the Ctrl-V keyboard shortcut.

About spell check
Blueprint provides a spell check so your requirements can be communicated more clearly. Within rich text fields,
misspellings are automatically detected and appear underlined in red. The built-in spell check recommends
spellings, letting you make the final decision about the right word for your requirement.

The spell check also lets you add a term to the Dictionary when a word is spelled correctly but the word does not
exist in the Blueprint Dictionary yet.

Blueprint allows you to ignore the detection of a misspelling at your convenience.

Recommended spellings

When Blueprint detects a misspelling in a rich text field, you can right-click the misspelling to view recommended
spellings. You can click the proper word, which replaces the misspelling.

Ignore all

When you want Blueprint to ignore the misspelling of a word in a rich text field, you can right-click the word and
select Ignore All.

As a result, Blueprint ignores all instances of the word in all of your projects.
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Adding a term to the Dictionary

Note: After you add a term to the Dictionary, you cannot remove the term from the Dictionary.

When you spell a term correctly and the word is mistaken for a misspelling, you can add the term to the Dictionary.

When you add a word to the Dictionary, the spelling of the word is accepted in all users's projects. The Dictionary is
a database of accepted terms that is shared by all users.

Example

Sam adds the term BankingCompanyTM to the Dictionary.
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Afterwards, Jesse types the term BankingCompanyTM in a rich text field within his artifact. The
typed word does not appear underlined in red because the term BankingCompanyTM now exists in
the Blueprint Dictionary.

The difference between Ignore All and Add to Dictionary

By using either feature (Ignore all or Add to Dictionary), you can make the detection of a misspelling (red
underlining) disappear.

However, performing the above operations (Ignore All and Add to Dictionary) affects users differently, as this table
demonstrates:

Operation applies to: Ignore All
Add to

Dictionary
Explanation

All projects When you use the Ignore All or Add to Dictionary
functionality, all projects are affected whether they are
open or closed.

All users Performing Ignore Alldoes not affect all users whereas
performing Add to Dictionary affects all users.

The difference between spell check and the glossary

Spell check detects the incorrect spelling of words.

A glossary is an artifact that contains compiled terms and definitions, often for shared use among project members
only.

Adding a term to the Dictionary
When you type a word that is mistaken for a misspelling, you can add the term to the Dictionary.

To add a term to the Dictionary:

Note: After you add a term to the Dictionary, you cannot remove the term from the Dictionary.

1. Type your word and then right-click your word.
The Add to Dictionary command appears.

2. Click Add to Dictionary.
Your word has been added to the Dictionary.

The spelling checker now accepts the spelling of the word in all users's artifacts and projects.

Disabling the spell checker
The spell checker detects misspellings within rich text fields. Misspellings appear in red and underlined.

You have the option of disabling the spell check.
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To disable the spell checker:

1. Click the application menu on the ribbon.

2. Click the Profile Options button on the application menu.

The Profile Options dialog box appears.

3. Select the Disable Spell Check check box.

4. Click OK.
Now the spell checker does not detect misspellings, nor suggest recommended spellings.

Enabling the spell checker
The spell checker detects misspellings within rich text fields. Misspellings appear in red and underlined.

To enable the spell checker:

1. Click the application menu on the ribbon.

2. Click the Profile Options button on the application menu.
The Profile Options dialog box appears.

3. Deselect the Disable Spell Check check box.

If you select the Disable Spell Check check box, the spell check no longer detects misspellings in rich text
fields.

4. Click OK.
The spell checker now detects misspellings in rich text fields and suggests recommended spellings.

About locks

Overview
The lock mechanism ensures that two people do not edit an artifact at the same time. The lock indicator appears
in the artifact list beside all artifacts that you are editing, regardless of whether your changes are saved or not.

Note: The lock will only appear if the artifact was previously published.

When you start editing an artifact and the lock indicator appears, other users cannot modify the artifact, unless
Steal Lock privileges are possessed. When an artifact is locked, other users only see the read-only indicator along
with the last published version of the artifact. Private changes are not made publicly visible to other users and the
lock is not released until you publish your changes.

When any user possesses the lock and is editing an artifact, any other user with Steal Lock privileges has the ability
to discard the previous user's changes. For more information on stealing a lock, see Stealing a lock.
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Stealing a lock

Note: Steal Lock is an action that is only available to users who are assigned to a role with the Steal Lock
privilege. For more information on role privileges, see Defining and managing project roles.

The Steal Lock feature is useful in situations when a person needs to edit an artifact but it is locked by another user.
Ideally, you would contact the user who holds the lock and ask them to either publish or discard their changes.
However, if the user is unreachable, it may be necessary to steal the lock.

Stealing a lock involves selecting or opening an artifact that is being edited by another user and discarding their
changes by clicking the Steal Lock button.

Stealing a lock effectively:

Deletes the other user's private draft

Releases the lock so other users can edit the artifact.

Warning: When the Steal Lock feature is used, all changes made by the current lock holder are lost! You
may want to contact the individual before discarding their changes to prevent the loss of work.

If you need to edit an artifact that is locked, you can verify who has locked it by opening the artifact. A header
appears with the name of the user that is currently editing the artifact.
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To steal a lock:

1. Open the locked artifact.

A header appears with the name of the user that is currently editing the artifact.

Warning: When the Steal Lock feature is used, all changes made by the current lock holder are
lost! You may want to contact the individual before discarding their changes to prevent the loss of
work.

2. Click the Steal Lock button (Home tab, Artifacts group).

The Steal Lock dialog appears.

3. To steal the lock and discard the other user's unpublished changes, click Yes.

The other user's changes have been discarded. You now have control to edit and publish changes to the
artifact.
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Artifact searching and browsing
Searching and browsing provides a fast and efficient way to locate artifacts in Blueprint. If you know where the
artifact is located, you may prefer to browse to find the artifact. If you remember part of the artifact name, or if
you can't recall the location of the artifact, it may be more efficient to use the search feature.

You can also search for artifacts and sub-artifacts within the selected project. To help you find artifacts more easily,
Blueprint allows you to restrict your search to a particular type of artifact.

The browse tab in the utility panel allows you to browse artifacts and sub-artifacts within any single project,
provided you have sufficient access to the project and the artifacts.

The browse tab in the utility panel looks like this:

A label is displayed at the top of every tab in the utility panel. It provides the ID and name of the artifact or sub-
artifact you are viewing. For example:

About search

Note: The search functionality is currently limited to audit properties and custom properties. Other
properties, such as the artifact description and status, are not included in the search.

Blueprint provides you with the ability to search for project and audit-related data.
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The search icon ( ) on the ribbon (Home tab, Artifactsgroup) allows you to
search for any of the following:

Artifacts and/or folders created by a certain user
Artifacts and/or folders last edited by a certain user
Artifacts and/or folders that were last edited before, on or after a specified date
Artifacts and/or folders that were created before, on or after a specified date

You can also search for data pertaining to any custom property (that is, any project administrator-created property)
as long as the custom property type is choice, number or date. Text and usercustom property types currently cannot
be included in searches.

Example

Maria is the team lead and project administrator of a requirements project that has multiple
contributors. Maria created amultiple-choice custom property (namedCost) to estimate team effort
as well as amultiple-choice custom property (namedRisk) to estimate the possibility of not
completing the work item. Jamal, a teammember, wants to find all of the high cost and high risk
artifacts in the project so that he can work on them. Jamal uses the search feature to find the artifacts
with high cost and high risk values in the shared project, as shown below:

Note: We highly recommend that project administrators use custom properties to organize project and
artifact data. In addition to enhancing project and content structure, custom properties can be searched
and filtered efficiently.

To refine your search, Blueprint allows you to use operators as well as specify values.

To narrow your search results, you can restrict your search to particular project(s). After you select one or more
projects, the properties you can search become available.

Using an operator in your search

To help refine your search, Blueprint provides a number of operators in the drop-down menu. Operators define
the relationship between a property and a specified value.

Note: In the example below, the user is searching for items that were completed after a specified date
(29/09/2013).
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Depending on your search criteria, you may be able to use any of the following operators:

Equal

Returns items with the specified value.

Not Equal

Returns items that do not have the specified value.

Empty

Returns items that do not have data in the specified property.

Is Not Empty

Only returns items that have data in the specified property.

Greater Than

Returns items that have occurred after the specified date or are greater than the specified number.

Less Than

Returns items that have occurred before the specified date or are less than the specified number.

Search results
After you submit search criteria, search results open in a new tab. You can filter and sort search results like you
would sort and filter artifacts in an artifact list.

Each search result shows up on a new line with the following details:

Project Name
Project Path
Name
ID
Description
Artifact Type
Artifact Path
Created By
Created On
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Last Edited By
Last Edited On

You can edit your search by clicking the query link at the top of the search results.

The maximum number of search results that can appear is 1000, which is a system configurable value.

Tip: You can export your search results to aMicrosoft Excel file by clicking the Artifact List View button
on the ribbon (Import/Export tab, Export group).

Searching projects

Note: The search functionality is currently limited to audit properties and custom properties. Other
properties, such as the artifact description and status, are not included in the search.

The search feature allows you to search any accessible project(s) of your choosing.

To do a search:

1. Click the Search button (Home tab, Artifactsgroup).

The Search dialog appears.

2. Select one of the Projects to Search options.

3. Select a property to search.

4. Select an operator.

When search criteria needs to be specified, the Value field appears.

5. To search another property, click .

6. Click Search.

A new tab appears with search results.

Searching for artifacts

Note: The search functionality is currently limited to artifact names. Other text, such as the artifact
description, are not included in the search.

Searching for artifacts and sub-artifacts provides a quick and easy way to find the artifact that you want to view or
modify. If you cannot find the artifact you are looking for, you may want to consider browsing instead. Read more
about Browsing artifacts.

To search for an artifact:

1. Select the project that you want to search.

To select a different project, simply click the project drop-down that is located under the search field. Then,
expand the folders until you locate the project you want. Click the project to display the contents in the
utility panel.

2. Select the artifact types that you want to search.
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To restrict your search to specific artifact types, click the drop-down arrow on the search button and
then place a checkmark beside the artifact types you want to search.

3. Type the search text into the search field.

The search text is NOT case sensitive.

4. Click the search button.

The search results are displayed in the panel after you click the search button.

The search results are displayed in an expanded tree view, helping you find the one you are looking for, even if
there are many similar results.

After you have located the artifact that you want, you can:

open the artifact
share the artifact
create a trace to/from the artifact

Browsing artifacts
You can browse for both artifacts and sub-artifacts within any project, provided you have sufficient access to the
project. By default, the current project is selected. If you cannot find the artifact you are looking for, you may want
to consider searching instead.

To browse artifacts using the utility panel:

1. Select the project that you want to browse.

To select a different project, simply click the project drop-down that is located under the search field. Then,
expand the folders until you locate the project you want. Click the project to display the contents in the
utility panel.

2. Expand the folders and artifacts to locate the artifact you are trying to find.

Simply click the expand buttons (or double-click the artifacts) to display the contents of each artifact.

After you have located the artifact that you want, you can:

open the artifact
share the artifact
create a trace to/from the artifact

Opening artifacts from the utility panel browse tab
While you are browsing or searching for artifacts, you may want to open an artifact from the browse tab in the
utility panel.

To open an artifact from the utility panel browse tab:

1. Open the browse tab in the utility panel.

Click the browse tab.

You can also point to the tab icon to view the name of the tab.

2. Right-click the artifact that you want to open.
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The context menu appears.

3. Click Open.

The artifact opens in a new tab in the main content area.



©2015 Blueprint Software Systems Inc. All rights reserved 43 of 183

Social collaboration
Blueprint offers a variety of features that facilitate collaboration in Blueprint:

Activity center
Discussion explorer
Notifications
Artifact follow
Commenting
Sharing artifacts

About the activity center
The activity center is a powerful feature that keeps you up-to-date about artifacts that you care about. It also
provides easy access to all reviews in which you are a participant.

You can access the activity center by clicking Activity Center in the explorer panel. The activity center appears in
the main content area. It displays recent activities on the left side, and on the right side it provides a list of all the
reviews to which you are a participant. The activity center looks like this:

Recent activities provide an overview of what is happening with artifacts that you care about in all of your projects,
not just the projects that you currently have opened. Blueprint displays up to 60 of the most recent activities.

Populating your activity center
There are two ways to start populating your activity feed:

Follow an artifact

Following an artifact in Blueprint is similar to following a person in other social media applications. When
you follow a Blueprint artifact, the activity center is populated with activities whenever users edit, delete, or
comment on that artifact. To follow an artifact, simply select the artifact and click the Follow button in the
artifact header.

You can follow an artifact in two ways:
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Manually follow an artifact by clicking the Follow button.
Automatically follow an artifact:

when you create a new artifact (authors automatically follow the artifacts they create).
when you comment on an artifact.
when you are mentioned in a comment by another user.

Participate in a review

When the review has been started or closed, your activity center is updated with a new activity.

Understanding the items that appear in your activity center
The following table outlines the activities that can appear in your activity center:

Activity
Type

This activity occurs when... This activity occurs because...

A new version of an artifact has been
published.

You are following the artifact with the newly
published version.

An artifact has been deleted. You are following the artifact that has been deleted.

A comment has been added to, or deleted
from, an artifact.

You are following the artifact with the added or
deleted comment.

You have been added to a review. You are a participant in the review.

You have been removed from an review. You were previously a participant in the review.

The review status has changed to active or
closed.

You are a participant in the review.

Removing items from your activity center
The actions button appears beside every activity in the activity center. This is the button you must use to remove
activities from your activity center. You can remove activities one at a time, or you can remove all review activities
(for a particular review) at once.

From the actionsmenu, you can also click the Unfollow Artifact option to prevent future activities from appearing
for that particular artifact.

Note: When remove items from your activity center, the action is cached. If you login to Blueprint using a
different browser or on a different computer, the activities will reappear.

To remove activities from your activity center:

1. Click the actions button located beside an activity.

2. Select Remove this Activity.

To remove all review activities (for a particular review) from your activity center:
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1. Click the actions button located beside a review activity.

2. Select Remove All Activities for this Review.

About discussions and commenting
Comments allow multiple stakeholders to collaborate on requirements. Blueprint users can add comments to any
artifact or sub-artifact, including (but not limited to) textual requirements, use cases, actors, use case steps,
diagrams, shapes in diagrams, glossaries, and glossary terms.

You may also be interested in learning how you can use the activity center to stay up-to-date about what's going on
in your projects.

The Discussions tab allows you to view comments, create new comments, reply to existing comments, and change
the status of discussons.

Note: Comments and replies cannot be deleted, unless your project administrator has enabled this
feature. You can collapse a discussion and change the status to closed. Read more about Changing the
status of a discussion.

The Discussions tab in the utility panel looks like this:

A label is displayed at the top of every tab in the utility panel. It provides the ID and name of the artifact or sub-
artifact you are viewing. For example:

Determining whether or not an artifact contains open discussions

When an artifact contains comments, the discussion indicator is displayed in a column in the artifact list. Click the
Column Options button on the ribbon (View tab, Artifact List group) to enable the display of this column.
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If you uncheck the Discussions option on the ribbon (View tab, Show Indicators group), the discussion indicator is
also displayed in the upper right corner of each sub-artifact (example: shape) that contains open discussions.
Example

Viewing comments in the utility panel
You can view comments for any artifact or sub-artifact by performing the following steps:

1. Open or select the artifact that contains the comments you want to view.

Click the artifact ID link of the artifact you want to open.

To view comments for sub-artifacts, select the sub-artifact (example: click a shape in a diagram).

2. Open the Discussions tab in the utility panel.

1. Click the Discussions tab icon.

You can also point to the tab icon to view the name of the tab.

Discussions can be expanded and collapsed by clicking anywhere on the header of the discussion, or by using the
expand and collapse buttons. When you click the collapse buttons, the entire discussion is collapsed,
including the original comment and all replies.

You can change the status of a discussion to either Open or Closed. The status is applied to the entire discussion. In
other words, you cannot assign a status to individual comments and replies. Read more about changing the status of
a discussion.

Note: Your project administrators may have configured custom discussion status values in addition to the
default status values of Open and Closed.

A discussion looks like this:

Adding a new comment
Comments allow multiple stakeholders to collaborate on requirements. Blueprint users can add comments to any
artifact or sub-artifact, including (but not limited to) textual requirements, use cases, actors, use case steps,
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diagrams, shapes in diagrams, glossaries, and glossary terms.

Note: Comments and replies cannot be deleted, unless your project administrator has enabled this
feature. You can collapse a discussion and change the status to closed. Read more about Changing the
status of a discussion.

To add a new comment to an artifact:

1. Open an artifact.

Click the artifact ID link of the artifact you want to open.

2. Open the Discussions tab in the utility panel.

1. Click the Discussions tab icon.

You can also point to the tab icon to view the name of the tab.

3. Click the New Comment link.

A new text field appears.

4. Type your comment into the space provided.

5. Click the Publish link located below the comment to publish it.

Note: You must publish your comments, or publish the artifact, before you comments can be viewed by
other users.

Mentioning a user in a comment
Comments allow multiple stakeholders to collaborate on requirements. Blueprint users can add comments to any
artifact or sub-artifact, including (but not limited to) textual requirements, use cases, actors, use case steps,
diagrams, shapes in diagrams, glossaries, and glossary terms.

Note: Comments and replies cannot be deleted, unless your project administrator has enabled this
feature. You can collapse a discussion and change the status to closed. Read more about Changing the
status of a discussion.

To mention a user in a comment:

1. Type the @ symbol while you are writing your comment followed by the name of the user you want to
mention. Example: @David

Blueprint displays a list of matching users.

2. Click the user that you want to mention in your comment.

After you publish the comment, the user that you mentioned receives an email notification if your instance
administrator has enabled email notifications. Also, the user that you mentioned is now automatically following the
artifact. By following the artifact, the user will receive updates about the artifact in the Activity Center.
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Replying to an existing comment
Comments allow multiple stakeholders to collaborate on requirements. Blueprint users can add comments to any
artifact or sub-artifact, including (but not limited to) textual requirements, use cases, actors, use case steps,
diagrams, shapes in diagrams, glossaries, and glossary terms.

Note: Comments and replies cannot be deleted, unless your project administrator has enabled this
feature. You can collapse a discussion and change the status to closed. Read more about Changing the
status of a discussion.

To reply to an existing comment:

1. Open an artifact.

Click the artifact ID link of the artifact you want to open.

2. Open the Discussions tab in the utility panel.

1. Click the Discussions tab icon.

You can also point to the tab icon to view the name of the tab.

3. Click the Reply link.

A new text field appears.

4. Type your comment into the space provided.

5. Click outside of the field to exit edit mode.

Note: You must publish your comments, or publish the artifact, before you comments can be viewed by
other users.

Changing the status of a discussion
There are two default discussion status values: Open and Closed. The discussion status can be helpful for keeping
track of which comments have already been addressed. For example, if a stakeholder's feedback has already been
addressed, the discussion can be set to Closed.

Note: Your project administrators may have configured custom discussion status values in addition to the
default status values of Open and Closed.

To change the status of a discussion:

1. Click the discussion status.

The following drop-down menu appears:

2. Select a status for the discussion.

Use the drop-down option to selectOpen or Closed.
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Note: Your project administrators may have configured custom discussion status values in addition
to the default status values of Open and Closed.

About artifact sharing
There are few different ways to share artifacts:

via e-mail
via a hyperlink (that can be included in an instant message or e-mail)
mention another user in a comment so the user receives an email notification

Sharing artifacts from the utility panel browse tab
Sharing artifacts allows you to easily direct other individuals to the artifact. Artifacts are shared using hyperlinks.

When you share a folder, the hyperlink contains an associated view. When another user opens the hyperlink, the
associated view is identical to your view of the artifact list at the time that you shared the folder.

You can share an artifact link via e-mail, or you can copy the link to the Clipboard and paste it into other applications
such as instant messaging.

To share an artifact (via e-mail):

1. Open the browse tab in the utility panel.

Click the browse tab.

You can also point to the tab icon to view the name of the tab.

2. Right-click the artifact that you want to open.

The context menu appears.

3. Click Share > Via e-mail.

A new email message is initiated in your default email program. The email message contains a link to the
artifact.

To share an artifact (via Clipboard):

1. Open the browse tab in the utility panel.

Click the browse tab.

You can also point to the tab icon to view the name of the tab.

2. Right-click the artifact that you want to share.

The context menu appears.

3. Click Share > Copy to Clipboard.

A link to the artifact is copied to the Clipboard so you can paste it into another application, such as email or
instant messaging.
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Traceability and relationships
A trace is a type of relationship between two artifacts or sub-artifacts. Traces are used to establish and define the
direction of a relationship.Blueprint allows you to create traces to/from any artifact or sub-artifact, with the
exception baseline and review artifacts.

The Relationships tab in the utility panel allows you to view and add artifact traces, effectively establishing
relationships with other artifacts.

The Relationships tab in the utility panel looks like this:

A label is displayed at the top of every tab in the utility panel. It provides the ID and name of the artifact or sub-
artifact you are viewing. For example:

Trace Types
There are 3 types of traces, depending on the direction of the relationship between two artifacts.

Icon Name Description

From Trace A From trace describes a one way relationship to an artifact From
the artifact in the utility panel.

To Trace A To trace describes a one way relationship from an artifact To the
artifact in the utility panel.

Bidirectional Trace A Bidirectional trace indicates a two way relationship between an
artifact and the artifact in the utility panel.

If a red exclamation point appears on the relationship indicator (example:  ), the trace relationship has been
marked with the suspect flag. Read more about Adding and removing the trace suspect flag.
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Viewing and filtering relationships
To view the relationships of an artifact, simply open the Relationships tab in the utility panel. The relationships are
displayed in a table. Example

The table contains the following columns:

The left most column indicates the type of trace. The trace type can be From, To, or Bidirectional.
The second column indicates the type of artifact, by displaying the artifact icon.
ID: The ID column indicates the unique ID of the artifact. You can click this link to open the traced artifact.
Title: The Title column indicates the name of the artifact.
Project: The Project column indicates the project the artifact belongs to.

To filter the information that appears in the Relationships tab, click the Relationships drop-down and select all of
types of relationships you want to appear in the table:

Traces: If selected, traces are displayed in the table.
Parent/Child: If selected, parent and child artifacts are displayed in the table.
Other: If selected, the following relationships are displayed:

Associations (see details)

UC Step to Actor
UC Step to UI Mockup
UC Step to Included UC
UC Step to External Alternate Flow

Inherited Actors
Document References

Adding traces from the relationships tab in the utility panel
Adding a trace establishes a relationship between two artifacts. Blueprint supports three different types of traces
depending on the direction of the relationship. Read more about Trace Types.

To add a trace using the Relationships tab in the utility panel:

1. Open the Relationships tab in the utility panel.

1. Click the Relationships tab .

You can also point to the tab icon to view the name of the tab.

2. Click the Add Trace link.

The Traces dialog appears.

Note: To trace an artifact across projects, you need Trace privileges for both projects and Create
and Edit privileges for either project. Contact your Blueprint project administrator for more
information about project role privileges.
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3. Select the artifact that you want to trace and establish a relationship.

Search or browse of the appropriate artifact on the left side of the dialog.

4. Select the type of trace to create.

Click the drop-down arrow located on the right side of the Trace button, and select To, From, or
Bidirectional.

Read more about Trace Types.

5. Click the Trace button.

The new trace appears on the right side of the dialog.

6. Click OK.

The trace is saved and now appears in the traces table on the Relationships tab in the utility panel.

After the trace is saved, it appears on the Relationships tab in the utility panel. If you do not see the new trace,
ensure that you have selected the Traces option in the Filter drop-down. Read more about Viewing and filtering
relationships.

Adding traces from the utility panel browse tab
A trace is a type of relationship between two artifacts or sub-artifacts. Traces are used to establish and define the
direction of a relationship.

The utility panel provides you with the ability to quickly create a trace between an artifact in the browse tab to an
artifact in the main content area or artifact list.

To add a trace from the browse tab in the utility panel:

1. Open the browse tab in the utility panel.

Click the browse tab.

You can also point to the tab icon to view the name of the tab.

2. Drag and drop the artifact that you want to trace onto an artifact in the main content area or artifact list.

You can drag and drop any artifact or sub-artifact from the browse tab. You can drag and drop the artifact
onto any artifact or sub-artifact in the main content area or artifact list.

After you drag the artifact, the trace menu appears.

3. Select the type of trace you want to add.

Select Add Trace, and then choose one of the following options:

To: Creates a trace from the artifact in the browse tab TO the artifact in the main content area.
From: Creates a trace to the artifact in the browse tab FROM the artifact in the main content area.
Bidirectional: Creates a two way (bidirectional) trace.
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Note: To trace an artifact across projects, you need Trace privileges for both projects and Create
and Edit privileges for either project. Contact your Blueprint project administrator for more
information about project role privileges.

Adding an inline trace
An inline trace creates a relationship between two artifacts and adds an inline hyperlink, allowing readers to click
the link to open the traced artifact. In addition to the hyperlink creation, the traced artifact also appears in the
Relationships tab in the utility panel.

You can add inline traces to any text field that supports rich text formatting. The Add InLine Trace button is located
on the ribbon (Home Tab, Relationships group) and is only accessible if you are editing a text field that supports rich
text formatting.

To add an inline trace:

1. Place your cursor in a text field that supports rich text formatting.

If the text field does not support inline traces, the Add InLine Trace button is inaccessible
(that is, grayed out).

2. Click the drop-down arrow on the Add InLine Trace button.

The drop-down arrow on the Add InLine Trace button looks like this:

3. Select the type of trace you want to add.

Read more about Trace Types for more information.

4. Click the Add InLine Trace button.

The Artifact Selection dialog appears.

Note: To trace an artifact across projects, you need Trace privileges for both projects and Create
and Edit privileges for either project. Contact your Blueprint project administrator for more
information about project role privileges.

5. Select the artifact that you want to trace and establish a relationship.

Search or browse of the appropriate artifact on the left side of the dialog.

6. Click OK.

A new hyperlink is added to the text field.

Note: If an existing trace relationship already exists, Blueprint displays a dialog that asks you if you want to
use the trace as it currently exists, or convert it to the selected trace type. Example
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After you add the inline trace, the trace appears as a hyperlink in your text field. Example

Changing the direction of a trace
You may need to change the direction of a trace if it was created incorrectly, or if a trace has changed from a one
way relationship to a two way relationship, or vice versa. In other words, you can modify the trace direction
without deleting and then re-creating the trace.

There are three trace direction types:

Icon Name Description

From Trace A From trace describes a one way relationship to an artifact From
the artifact in the utility panel.

To Trace A To trace describes a one way relationship from an artifact To the
artifact in the utility panel.

Bidirectional Trace A Bidirectional trace indicates a two way relationship between an
artifact and the artifact in the utility panel.

You can view the direction of a trace by opening the Relationships tab in the utility panel. The first column of the
table displays an direction icon for each trace.

To change the direction of a trace:

1. Open the Relationships tab in the utility panel.

1. Click the Relationships tab .

You can also point to the tab icon to view the name of the tab.

2. Right-click the trace that has the incorrect direction.

The context menu appears.

3. Select Change Direction and then choose the direction you want.

A checkmark appears beside the trace direction that is currently selected.

After you change the trace direction, the icon is updated in the traces table (on the Relationships tab in the utility
panel).

Adding and removing the trace suspect flag
When a trace is marked with a suspect flag, it generally indicates that one of the traced artifacts has changed, and as
a result, the traced artifacts may require changes as well. Therefore, if you change an artifact, it is best practice to
mark the traced artifacts as suspect so they can be reviewed and updated at a later time.

In the utility panel, traces that are marked with the suspect flag are displayed with a red exclamation point on the
relationship indicator (example: ).

A red exclamation point is also displayed on the relationship indicator if the artifact or sub-artifact contains at least
one suspect trace. For example, if a shape (sub-artifact) contains at least one suspect trace, the relationship
indicator is displayed with a red exclamation point in the diagram. Example
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To add or remove the trace suspect flag:

1. Open the Relationships tab in the utility panel.

1. Click the Relationships tab .

You can also point to the tab icon to view the name of the tab.

2. Right-click the trace that you want to mark or unmark with the suspect flag, and then click Suspect.

The context menu appears after you right-click the trace. If the suspect flag is already set, a checkmark
appears beside the Suspect menu option:

After you have marked a trace with the suspect flag, a red exclamation point appears on the relationship
indicator. Also, a checkmark appears beside the Suspect option on the context menu.

Deleting a trace

Warning: Deleted traces cannot be restored. Unless you are sure you want to delete the trace, consider
marking the trace with the suspect flag instead of deleting the trace.

Deleting a trace removes the relationship between two artifacts. After a trace is deleted, the trace no longer
appears on the Relationships tab in the utility panel.

Tip: If you suspect that a trace is inaccurate or invalid, you may wish to mark it with the suspect flag
instead of deleting the trace. Read more about Adding and removing the trace suspect flag.

To delete a trace, perform the following steps:

1. Open the Relationships tab in the utility panel.

1. Click the Relationships tab .

You can also point to the tab icon to view the name of the tab.

2. Right-click the trace that you want to delete.

The context menu appears.

3. Click Delete and then choose the direction you want.

The confirmation dialog appears.

4. Confirm the deletion.

Warning: Deleted traces cannot be restored. Unless you are sure you want to delete the trace,
consider marking the trace with the suspect flag instead of deleting the trace.
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About the traceability explorer
In the Traceability Explorer, you can view the trace relationships between selected artifacts in a grid layout or
matrix.

Note: Artifacts that are not covered are called orphaned and are displayed in red font.

To learn more on the topic of trace relationships, see Traceability and relationships.

The matrix lays out the trace relationships like an interactive Excel spreadsheet. The header rows and header
columns contain any selected projects, folders and artifacts with direct hyperlinks to the original artifacts. At the
center of the matrix, you can view the trace relationships that exist between the intersecting artifacts. The
Traceability Explorer allows you to perform visual analyses of your trace relationships. For example, you can use
the trace matrix to identify if you need to add any traces to a set of artifacts.

The Traceability Explorer also allows you to do the following:

After the matrix is generated, you can still change the scope and filter the relationships that are displayed.
You can filter by relationship type, relationship direction and suspect flag. After making changes, click the
Generate Matrix button to re-generate the traceability matrix.
You can click the Refresh button at any time to refresh the information in the traceability matrix. This can be
useful if you modify artifacts and want the traceability matrix to reflect the changes.
You can run cross-project coverage analysis. Simply click the drop-down below the search boxes on the
Matrix Scope Selection dialog and select another project.

Exporting a traceability matrix to Microsoft Excel
Blueprint allows you to conveniently export your traceability matrix to Microsoft Excel. You can then print your
traceability matrix.
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For more information about the in-Blueprint traceability matrix layout, see About the traceability explorer.

Hyperlinks and icons are not preserved in the exported Excel spreadsheet.

Exporting a traceability matrix to Excel

To export a traceability matrix to Excel:

Important: If you have made any layout changes to your trace matrix, you should click Generate Matrix
to finalize the changes before exporting your matrix (Traceability Explorer tab).

1. Click Export (Traceability Explorer tab).

The Save As dialog box appears.

2. Save your file as an .xls document in your desired location and then click Save.
You have successfully exported your traceability matrix to Excel. You can now open your file in Excel.

Exporting a traceability matrix to Microsoft Word
Blueprint allows you to conveniently export your traceability matrix to Microsoft Word. You can then print your
traceability matrix.

For more information about the in-Blueprint traceability matrix layout, see About the traceability explorer.

Hyperlinks and icons are not preserved in the exported Word document.

Exporting a traceability matrix to Word

To export a traceability matrix to Word:
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Important: If you have made any layout changes to your trace matrix, you should click Generate Matrix
to finalize the changes before exporting your matrix (Traceability Explorer tab).

1. Click Export (Traceability Explorer tab).

The Save As dialog box appears.

2. Save your file as an .doc document in your desired location and then click Save.
You have successfully exported your traceability matrix to Word. You can now open your file in Word.

Viewing trace relationships in a matrix
The Traceability Explorer allows you to perform visual analyses of your trace relationships. For example, you can
use the trace matrix to identify if you need to add any traces to a set of artifacts.

To view the trace relationships between your artifacts in a matrix:

1. Select the artifacts that you want to include in your matrix.

2. Click Open Traceability Explorer (Home tab, Relationships group).

The Matrix Scope Selection dialog box appears.

3. If desired, you can remove artifacts or add more artifacts to the matrix scope.

Click OK.

The Traceability matrix confirmation dialog box may appear, informing you that the matrix may take some
time to generate.

To prevent the message from appearing when generating matrices in the future: select Do not show this
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message again.

Click Yes to continue.

The Traceability Explorer appears in the main content area.

Note: Artifacts that are not covered are called orphaned and are displayed in red font.

The Traceability Explorer tab appears on the ribbon with various commands for re-defining scope, filtering the
matrix, regenerating the matrix and exporting the matrix to other programs.
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File attachments and document references
File attachments and document references allow you to associate content in a file (or document) with an artifact or
sub-artifact. A document reference is an existing document artifact that you can associate with one or more
artifacts. A file attachment is a file that you upload and associate with a single artifact.

Example

Jeff, a business analyst, is working on a business process and wants to add a photo of a rough
diagram that was drafted during a recent meeting. In this case, Jeff uploads the photo as a file
attachment because he does not intend to reference the photo from any other artifacts.

Example

Joe, from the legal department, recently created a new document artifact and uploaded a terms and
conditions document. The terms and conditions must be accepted by users prior to creating a new
account in the system.

Sally, a business analyst, has been notified by the legal department that users must accept the same
terms and conditions prior to using the system tomake a purchase. In this case, Sally opens the
Purchase use case, and adds the terms and conditions as a document reference. Now, there are
multiple references to the same document artifact.

Document artifacts are different than file attachments. Document artifacts can be referenced from multiple
artifacts by adding it as a document reference to other artifacts in the utility panel files tab. File attachments are
also added in the files tab of the utility panel and are associated with a single artifact.

The files tab allows you to view, add, and delete artifact file attachments and document references. The files tab in
the utility panel looks like this:

A label is displayed at the top of every tab in the utility panel. It provides the ID and name of the artifact or sub-
artifact you are viewing. For example:
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Determining whether or not an artifact contains file attachments or
document references
When an artifact contains file attachments or document references, the files indicator is displayed in the Icons
column in the artifact list. Click the Column Options button on the ribbon view tab to enable the display of this
column.

You can also view the file indicator in the upper right corner of each sub-artifact (example: shape) that contains file
attachments or document references.

Adding a file attachment to an artifact
A file attachment is a file that you upload and associate with a single artifact. Blueprint allows you to add multiple
file attachments to an artifact.

Tip: If you plan to upload the file to multiple artifacts, you may want to create a document artifact instead.
If you create a document artifact, you can then add a document reference to multiple artifacts.

Note: Blueprint enforces a maximum file size for file attachments. The maximum file size is configurable
by your project administrators.

To add a file attachment to an artifact:

1. Open an artifact.

Click the artifact ID link of the artifact you want to open.

2. Open the files tab in the utility panel.

Click the files tab icon.

3. Click New and select Add Attachment.
4. Select the file that you want to attach.

Search or browse to locate the file that you want to upload and attach to the artifact.

5. Click Open.

Adding a document reference to an artifact
A document reference is an existing document artifact that you can associate with one or more artifacts. Blueprint
allows you to add multiple document references to an artifact.

Before you can add a document reference to an artifact, the document artifact must already exist. If the document
has not already been uploaded to a document artifact, you may want to create a document artifact. Read more
about Adding a document artifact.

Tip: If the document is only applicable to a single artifact, you may want to add the document as a file
attachment instead. See Adding a file attachment to an artifact and File attachments and document
references for more information.
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To add a document reference to an artifact:

1. Open an artifact.

Click the artifact ID link of the artifact you want to open.

2. Open the files tab in the utility panel.

Click the files tab icon.

3. Click New and select Add Document Reference.
4. Select the document artifact that you want to reference.

Search or browse to locate the document artifact that you want to reference.

5. Click OK.

Opening a file attachment or document reference
You can open file attachments and document references directly from the files tab in the utility panel. Blueprint
also provides you with an easy way to open the document artifact for any existing document references.

To open a file attachment or document reference:

1. Open the artifact that contains the file attachment or document reference that you want to view.

Click the artifact ID link of the artifact you want to open.

2. Open the files tab in the utility panel.

Click the files tab icon.

3. Right-click the file attachment or document reference that you want to view.

The context menu appears.

4. Click Open.

When you open a file attachment or document reference, the file is automatically downloaded to your
computer in a temporary directory. Your computer then decides which application is most appropriate for
opening the file.

Tip: You can also open the document reference artifact by selecting Open In Application.

Deleting a file attachment or document reference
When you delete a file attachment, the file is permanently removed from the system and is not available in
historical versions of the artifact. However, when you delete a document reference, the reference is removed but
the document artifact remains available in the system.

To delete a file attachment or document reference:

1. Open the artifact that contains the file attachment or document reference.

Click the artifact ID link of the artifact you want to open.

2. Open the files tab in the utility panel.

Click the files tab icon.
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3. Right-click the file attachment or document reference that you want to delete.

The context menu appears.

4. Click Delete.

Warning: There is no delete confirmation dialog. The file attachment or document reference is
immediately removed. However, the deletion is not permanent until after you publish your
changes.

Note: You must publish the artifact before your changes are viewable by other users.
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Textual requirements
A textual requirement artifact is a documented property or capability that a product must possess to provide value
to a stakeholder. In this case, the requirement is documented in a textual (as opposed to visual) form.

Textual requirements are beneficial if you need to capture requirements rapidly. Once captured, textual
requirements are often used as the basis for visualizing requirements using other types of artifacts such as use
cases and UI mockups.

Textual requirements, like all other artifacts, can be organized in a hierarchy. You can enhance your textual
requirements by taking advantage of rich text formatting. You can also attach files to your textual requirements,
and trace your textual requirements to other artifacts.

To support your existing business processes and standards, project administrators can customize the set of
requirement types, and create other custom properties as needed.

Textual Requirement Artifact Properties
By default, a textual requirement artifact contains the following system properties:

Name: Indicates the name of the textual requirement.
Id: Provides a unique identifier for the textual requirement. The Id cannot be modified.
Type: Indicates the type of artifact.
Description: Provides the description of the textual requirement.

In addition to the default system properties, your project administrator can configure custom properties for each
artifact type.

Adding a textual requirement

To add a textual requirement artifact:

1. Click the New button on the ribbon (Home tab, Artifacts group).
2. Select Child Artifact.

3. Click the textual requirement icon.

Creating and editing textual requirement content
You can edit a textual requirement from the artifact list, or by opening the artifact. You may be interested in
learning more about keyboard navigation shortcuts to improve your efficiency.

Tip: If you are editing many requirements at once, it may be more efficient to edit the content directly
from the artifact list, which provides you with an edit in place experience.

To do this, use the Column Options button on the View tab and select only the fields you need to see in
the artifact list. Next, place a checkmark in the Wrap Text option. You can now view the textual
requirements in a table style. Example
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Simply click the Description of any textual requirement to edit the text. You can also take advantage of rich
text formatting.

To create or edit textual requirement content:

1. Open a textual requirement artifact.

Click the artifact ID link of the textual requirement artifact you want to open.

2. Provide a name for the textual requirement.

Type a name into the Name field.

Tip: We recommend that you choose a name that is descriptive, but relatively short in length.

3. Set the textual requirement type.

Click the Type drop-down menu and select a type from the drop-down list. There is only one type by
default (Textual Requirement), but your project may have custom types configured (example: Business
Requirement or Functional Requirement).

4. Set any additional custom properties.

Custom properties vary from project to project and are configured by your Blueprint project administrator.

5. Provide a description for the textual requirement.

See Using the textual requirements editor for more information about formatting and enhancing your
textual requirements in Blueprint.

Note: You must publish the artifact before your changes are viewable by other users.

Using the textual requirements editor

To enhance your requirements, you may want to use the utility panel to add an attachment or create a trace to
other artifacts. You can also take advantage of many rich text formatting features, such as creating lists or adding a
hyperlink to your textual requirements.
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Rich text formatting

Blueprint provides you with the ability to create textual content using rich text formatting. In other words, you can
perform many of the operations that you can perform using a word processing application. The rich text formatting
features are available on the ribbon Home tab:

Here's a list of the rich text formatting features offered by Blueprint:

Change font type, color, and size
Make the font bold, italic, underline, subscript, superscript, strikethrough
Apply highlighting to font
Add a hyperlink
Create a bulleted or numbered list
Change the paragraph justification

Deleting a textual requirement

To delete a textual requirement:

1. Open the textual requirement that you want to delete, or select the textual requirement in the artifact list.

To open an artifact, click the artifact ID link that is displayed in the ID column of the artifact list. Or,
right-click the artifact in the artifact list and then click Open.
To select an artifact, click a row in the artifact list.

2. Click Delete.

You can find the Delete button in the following locations:

on the ribbon (Home tab, Artifacts group).
on the context menu when you right-click an artifact in the artifact list.

After you click delete, the Confirmation dialog appears.

3. Confirm the deletion.

Click Yes to confirm deletion, or click No to cancel.

About rich text formatting
Blueprint provides you with the ability to create textual content using rich text formatting. In other words, you can
perform many of the operations that you can perform using a word processing application. The rich text formatting
features are available on the ribbon Home tab:

Here's a list of the rich text formatting features offered by Blueprint:
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Change font type, color, and size
Make the font bold, italic, underline, subscript, superscript, strikethrough
Apply highlighting to font
Add a hyperlink
Create a bulleted or numbered list
Change the paragraph justification

Rich Text Formatting in the Artifact List

Rich text formatting is displayed differently in the artifact list depending on the current mode. Here's an
explanation of the different modes and the way rich text formatting is displayed:

Edit in-place mode
all rich text formatting is displayed.

Non-edit and wrap text disabled:
text is displayed as plain text.

on hover, a tooltip displays a limited amount of rich text. Bullets and lists are not displayed in the
tooltip.
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Non-edit and wrap text enabled:
displays a limited amount of rich text. For example: Highlighting, bullets and lists are not displayed.
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Actors
An actor can be any person, role, organization, application, system, and so on, that interacts with the system being
modeled.

After you have created actor artifacts, you can set one or more actors for each step in a use case. The purpose of
creating actor artifacts is to include them in use case steps.

Actor Artifact Properties
By default, an actor artifact contains the following system properties:

Name: Indicates the name of the actor.
Id: Provides a unique identifier for the actor. The Id cannot be modified.
Type: Indicates the type of artifact.
Inherits From: If the actor is inherited from another actor (that is, a parent), this property indicates the
name and ID of the parent actor.
Image: Indicates the filename of the actor image.
Description: Provides a description of the actor.

In addition to the default system properties, your project administrator can configure custom properties for each
artifact type.

Adding an actor artifact
An actor can be any person, role, organization, application, system, and so on, that interacts with the system being
modeled.

To add an actor artifact:

1. Click the New button on the ribbon (Home tab, Artifacts group).
2. Select Child Artifact.

3. Click the actor icon.

After you have added a new actor artifact, you may want to set actor inheritance or set a custom image for the
actor. You may also want to associate the actor with a use case step.

Setting and removing actor inheritance
Actor inheritance allows you to establish relationships between actors.

Note: When you set actor inheritance, a relationship is established, but no properties are shared between
the actors. Actor Inheritance creates a special relationship between actors. Property values of the parent
actor are not automatically set as properties for the child.
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Example

Sally, a business analyst, has created two actors: Part Time Employee and Full Time Employee.
Some of her use case steps can be performed by both actors. Instead of including both actors in each
use case step, Sally creates a third actor called Employee. She thenmodifies the two existing
actors and sets the Inherits From property to the new Employee actor. Now, Sally can simply
include the new Employee actor in the use case steps because the other actors inherit from the
Employee actor.

To set the inheritance of an actor:

1. Open an actor artifact.

Click the artifact ID link of the actor artifact you want to open.

2. Click the Edit link located under the Inherits From property.

The Select Actor dialog appears.

3. Search or browse to select an actor.
4. Click OK.

The OK button is only accessible if you have selected an actor artifact.

After you have set the Inherits From property, Blueprint displays the ID and name of the actor:

You can also view the actor inheritance on the Relationships tab in the utility panel if you selectOther in the Traces
drop-down:

To remove the inheritance of an actor:

1. Open an actor artifact.

Click the artifact ID link of the actor artifact you want to open.

2. Click the Remove link located beside the Inherits From property.

Setting and removing an actor image
When you set a custom image for an actor, the image appears in simulations when the actor is set on a use case
step. This provides viewers with a visual indication of what actor is performing that particular step in the use case.

To set a custom image for an actor:
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1. Open an actor artifact.

Click the artifact ID link of the actor artifact you want to open.

2. Click the Edit link located under the Inherits From property.

After you click the link, the Open dialog appears.

3. Select the image file that you want to associate with the actor.
After you have set the actor image, Blueprint displays the picture in the rectangular box above the Edit link.

To remove a custom image for an actor:

1. Open an actor artifact.

Click the artifact ID link of the actor artifact you want to open.

2. Click the Remove link located under the image.

Deleting an actor artifact

Note: After you delete an actor artifact, the artifact can only be accessed in read-only mode. Any use case
steps that are associated with an actor will link to the read-only version of the deleted artifact.

To delete an actor:

1. Open the actor that you want to delete, or select the actor in the artifact list.

To open an artifact, click the artifact ID link that is displayed in the ID column of the artifact list. Or,
right-click the artifact in the artifact list and then click Open.
To select an artifact, click a row in the artifact list.

2. Click Delete.

You can find the Delete button in the following locations:

on the ribbon (Home tab, Artifacts group).
on the context menu when you right-click an artifact in the artifact list.

After you click delete, the Confirmation dialog appears.

3. Confirm the deletion.

Click Yes to confirm deletion, or click No to cancel.
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Use cases
A use case describes an interaction between an actor and the system that yields an “observable result of value” to
the actor.

Use cases are defined in order to specify all the different ways the system can be used. A complete set of use cases
defines all behavior required of the system, effectively bounding the scope of the system without defining any of
the system internals. Generally, use case steps are written using a structured narrative that is easy to understand.
Use cases should be easy to follow and engaging for users, in order to ease the validation of each use case.

One of the benefits of creating use cases in Blueprint is the ability to simulate them. Use cases can be simulated
using UI mockups to promote a clear understanding of the requirements and enhance the feedback provided by
stakeholders.

Blueprint's use case editor provides you with the ability to easily create and edit use case artifacts. The use case
editor looks like this:

Use Case Artifact Properties
By default, a use case artifact contains the following system properties:

Name: Indicates the name of the use case.
Id: Provides a unique identifier for the use case. The Id cannot be modified.
Type: Indicates the type of artifact.
Use Case Level: Indicates the level of detail of the use case, measured from 1 (high level) to 10 (low
level). Use cases can be automatically excluded from simulation or test case generation based on the Use
Case Level.
Description: Provides a description of the use case.

In addition to the default system properties, your project administrator can configure custom properties for each
artifact type.
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About the use case editor layout
The use case editor layout allows you to create use cases in either text view,workflow view, or split view (both text
view and workflow view). Try out the different views and choose which ones works best for you. Various
customizations are available for each view.

The use case editor looks like this:

Use Cases Group on the Ribbon View Tab

There are a number of features on the View tab of the ribbon that allow you to customize the layout of the use
case editor, as well as customize the look and feel of the diagram. The Use Cases group on the View tab looks like
this:

The view and customization options include:

Views: Allows you to select your desired view while working with a use case artifact.
The view options are:

Split: Displays both the text view and the workflow view in the main content area.

Text: Displays the text view only, without the workflow view.

Workflow: Displays the workflow view only, without the text view.

Tip: To make more space available to view your artifact(s), you can collapse both the utility
panel and the explorer panel by clicking the full screen button (the lower rightmost
corner of the window).

Full Text: Displays the text of each use case step on a single line. This layout utilizes vertical space more
efficiently, allowing you to view more use case steps in the main content area without scrolling.
Alternate Layout: Displays the diagram in a way that uses less vertical space, at the expense of more
overlapping connectors.
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Curved Lines: Displays the use case connectors using a curved line style. Curved lines are helpful if the use
case has a number of alternative flows where the entrance and exit connectors overlap with other flow
connectors. By switching to a curved line, the connector overlap is reduced.
Expand All: Allows you to expand the alternate flows in workflow view. If you click Expand All, the alternate
flows are displayed in full detail in the diagram.

Note: You can also use the expand buttons in workflow view and text view .

Collapse All: Allows you to collapse the alternate flows in workflow view. If you click Collapse All, the
alternate flows are collapsed.

Note: You can also use the collapse buttons in workflow view and text view .

Use Cases Ribbon Tab

When the use case editor is open, a Use Cases tab appears on the ribbon, providing you with various editing
features. The Use Cases tab looks like this:

Step group:

Add Step: Adds a new step to the use case, directly below the selected step.
Set Actor: Associates an actor with the selected use case step, pre condition, or post condition.
Set UI Mockup: Associates a UI mockup with the selected use case step(s).
Remove UI Mockup: Removes a UI mockup from the associated use case step(s).

Include Use Case: Associates a use case with the selected use case step. Including a use case in a step can
be beneficial when a step is high level and you want to link the step to another use case that demonstrates
the lower level steps that are required to complete that particular step. It also provides a way to reuse
common functions across multiple use cases.
Move Step Up: Moves the selected step(s) up one position in the use case.
Move Step Down: Moves the selected step(s) down one position in the use case.
Delete Step(s): Deletes the selected step(s).
Merge Steps: Merges two or more selected use cases into a single use case step.

Flow group:

Add Alternate Flow: Allows you to add an internal or external alternate flow.
Add Internal Flow: Adds an internal alternate flow to the use case. An internal alternate flow is an
alternate flow defined within a use case.
Add External Flow: Adds an external alternate flow to the use case. An external alternate flow is an
alternate flow that is included from an separate use case.

Set Start/Return Steps: Allows you to set the start and return steps for an alternate flow.
Move Flow Up: Moves the selected alternate flow up one position in the use case.
Move Flow Down: Moves the selected alternate flow down one position in the use case.
Change External Use Case: Changes the use case artifact of an external alternate flow to another use case
artifact.

Simulate: Starts a simulation from the beginning of the use case.
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Adding a use case

To add a use case artifact:

1. Click the New button on the ribbon (Home tab, Artifacts group).
2. Select Child Artifact.

3. Click the use case icon.

After you have created a use case artifact, you may want to consider adding actors before building your use case
content.

Building a use case
A use case consists of one or more flows, which are built using a sequence of use case steps. Every use case has a
main flow that generally describes the main, or default, path through the use case.

Blueprint allows you to add alternate flows to your use cases. Alternate flows begin after a decision point, where
the use case splits into two or more directions. An external alternate flow is the same as an internal alternate flow,
except the flow is contained in a separate use case artifact.

Use case steps are typically associated with an actor, and are sometimes associated with UI mockups and other use
cases. Actors are associated with use cases to clearly demonstrate the person or system that performs that task.
Associating UI mockups with use case steps enhances the simulation experience, providing viewers with a richer
and clearer understanding of the use case. Including a use case in a step can be beneficial when a step is high level
and you want to link the step to another use case that demonstrates the lower level steps that are required to
complete that particular step. It also provides a way to reuse common functions across multiple use cases.

Key Terms and Concepts

A use case describes an interaction between an actor and the system that yields an “observable result of
value” to the actor.

An actor can be any person, role, organization, application, system, and so on, that interacts with the system
being modeled.

A pre condition lists the state(s) that must be true before the use case can begin.

A post condition lists the state(s) that will always be true at the completion of the use case, regardless of the
path or scenario followed.

A use case step describes a discrete action performed by an actor or by the system being modeled.

A main flow describes the typical set of steps that should occur in order to satisfy the post conditions of the
use case.

An alternate flow describes an optional series of steps that satisfies the post conditions of the use case.

An internal alternate flow is an alternate flow defined within a use case.

An external alternate flow is an alternate flow that is included from an separate use case.
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A UI Mockup is a prototype of a user interface in the system. UI mockups are effective on a standalone
basis, but are even more powerful when they are viewed in simulations.

Typical use case creation

Use cases are typically created as follows:

1. Define the pre condition and the post condition.
2. Add new use case steps to define the main flow.
3. Set actors on the use case steps.
4. Include use cases in the use case steps, if applicable.
5. Add alternate flows, if applicable
6. Add UI mockups to the use case steps, to enhance the simulation experience.

Use Case Example

The following example shows a use case in split view, which includes both the text view and the workflow view in
the main content area at one time.

Adding use case steps
A use case describes an interaction between an actor and the system that yields an “observable result of value” to
the actor.

A use case step describes a discrete action performed by an actor or by the system being modeled.

Note: You can only add one use case step at a time.
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To add a use case step:

1. Select a use case step.
In text view, place the cursor on a use case step by clicking anywhere on the use case text.
In workflow view, click a use case step.

2. Click Add Step.

Choose one of the following options to add a use case step:

Click the Add Step button on the ribbon (Use Cases tab, Step group).
Click the Add Step option on the context menu when you right-click an existing use case step.

The new step is added directly after the selected step.

Tip:

If you are using text view, you can easily add a new step by pressing the Enter key when your cursor is
positioned on an existing use case step.

To add a line break, press Shift+Enter.

Deleting use case steps
You can delete use case steps using a variety of methods, depending on whether you are building your use case
using text view or workflow view.

To delete a use case step:

1. Select the use case step(s) that you want to delete.

In text view, use your mouse to select the text of one or more use case step(s).
In workflow view, click a use case step. You can select multiple steps in workflow view by holding
the Ctrl key and clicking multiple steps, or by drawing a box around a group of steps.

2. Click Delete Step(s).

Choose one of the following options to delete the use case step(s):

Click the Delete Step(s) button on the ribbon (Use Cases tab, Step group).
Click the Delete Step(s) option on the right-click context menu.
Click the Delete key on your keyboard.

Merging use case steps
Merging use case steps is useful whenever you want to combine multiple steps into one use case step. When you
merge steps, the text from each step is preserved but combined into a single step. Blueprint allows you to merge
two or more steps at one time.

To merge two or more use case steps:
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1. Select two or more use case steps that you want to merge.

In text view, use your mouse to select the text of one or more use case step(s).
In workflow view, click a use case step. You can select multiple steps in workflow view by holding
the Ctrl key and clicking multiple steps, or by drawing a box around a group of steps.

2. ClickMerge Steps.

You can use the following buttons to merge use case steps:

the Merge Steps button on the ribbon (Use Cases tab, Step group)
the Merge Steps option on the right-click context menu

After you have successfully merged two or more use case steps, the text from both steps are merged into a single
use case step.

Tip: In textual view, you can also merge two steps by pressing the Backspace key at the beginning of a
step, or by pressing the Delete key at the end of a step.

Rearranging the order of use case steps and flows
While you are creating or editing a use case, you may need to move steps or flows up or down. Blueprint provides
some easy ways to perform this task.

To move steps up or down within the flow:

1. Select the step(s) that you want to move.

In text view, use your mouse to select the text of one or more use case step(s).
In workflow view, click a use case step. You can select multiple steps in workflow view by holding
the Ctrl key and clicking multiple steps, or by drawing a box around a group of steps.

2. ClickMove Step Up or Move Step Down.

Choose one of the following options to move the step(s) up or down:

Click the Move Step Up or Move Step Down button on the ribbon (Use Cases tab, Step group).
Click the Move Step Up or Move Step Down option on the right-click context menu.

To move a flow up or down within the use case:

1. Select the flow that you want to move.

In text view, place the cursor on the text of an alternate flow.
In workflow view, click a use case step in the alternate flow.

2. ClickMove Flow Up or Move Flow Down.

Choose one of the following options to move the step(s) up or down:

Click the Move Flow Up or Move Flow Down button on the ribbon (Use Cases tab, Flow group).
Click the Move Flow Up or Move Flow Down option on the right-click context menu.
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Adding an actor to a use case step
An actor can be any person, role, organization, application, system, and so on, that interacts with the system being
modeled.

Adding actors to your use case steps is beneficial because it helps to more clearly illustrate the interaction between
the person (or abstract entity) and the system.

Note: You can only set actors on use case steps one at a time.

To add an actor to a use case step:

1. Select a use case step.
In text view, place the cursor on a use case step by clicking anywhere on the use case text.
In workflow view, click a use case step.

2. Click Set Actor.

Choose one of the following options to add an actor to a use case step:

Click the Set Actor button on the ribbon (Use Cases tab, Step group).
Click the Set Actor option on the right-click context menu.

After you have successfully added an actor, the name of the actor is included as a link in the use case step. You can
click the actor link to view the actor details. Here's an example of the actor link in workflow view:

Including a use case in a step
A use case step describes a discrete action performed by an actor or by the system being modeled.Including a use
case in a step can be beneficial when a step is high level and you want to link the step to another use case that
demonstrates the lower level steps that are required to complete that particular step. It also provides a way to
reuse common functions across multiple use cases.

Example

Sam, a business analyst, is creating a series of use cases for a web application. All of the use cases
require that the user logs into the system before using any other features.

Sam starts by creating a Login use case. She then includes that use case at the beginning of all
other use cases, instead of duplicating the login steps.

When Sam realizes shemust make a change to the Login use case, she only has to update one use
case instead of 20.

To add a use case to a use case step:

1. Select a use case step.
In text view, place the cursor on a use case step by clicking anywhere on the use case text.
In workflow view, click a use case step.
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2. Click Include Use Case.

You can use the following buttons to add a use case to a use case step:

the Include Use Case button on the ribbon (Use Cases tab, Step group)
the Include Use Case option on the right-click context menu

After you have successfully associated a use case with a step, the name of the included use case is displayed as a
link in the use case step. You can click the use case link to view the details of the included use case. Here's an
example of the included use case link in workflow view:

Adding an internal alternate flow
An internal alternate flow is an alternate flow defined within a use case.

Alternate flows allow you to demonstrate the behavior of the system, given a particular condition. For example, the
system will behave differently depending on whether the user clicks Yes or No after a confirmation dialog is
displayed.

To add an internal alternate flow to a use case:

1. Select the step where you want the alternate flow to begin.
In text view, place the cursor on a use case step by clicking anywhere on the use case text.
In workflow view, click a use case step.

2. Click Add Alternate Flow > Internal.

Choose one of the following options to add an internal alternate flow:

Click the Add Alternate Flow drop-down on the ribbon (Use Cases tab, Step group) and then select
Internal.
Click the Add Internal Flow option on the right-click context menu.

3. Set the start and return steps.

You can use the following buttons to set the start and return steps:

the Set Start/Return Steps button on the ribbon (Use Cases tab, Flow group)
the Set Start/Return Steps option on the right-click context menu

After you have added an alternate flow, a decision point appears in workflow view. In text view, a new flow
appears under the Alternate Flows heading.

In workflow view, you can expand and collapse the alternate flow using the expand and collapse icons. In text
view, you can expand and collapse the alternate flow using the expand and collapse icons.

Note: Alternate flows are labeled the same way in both text view and workflow view. Conditions that are
peers end in letters (example: 2a, 2b, and 2c). The regular steps in the flows end in numbers based on the
condition. Therefore, condition 2a has steps labeled 2a1, 2a2 and so on.
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Flow Conditions

The first step in an alternate flow is a condition. Also, the step in the main flow immediately after the decision point
also becomes a condition. The text of the condition steps must indicate under what condition the main flow and
the alternate flow will be exercised.

In the example below, the alternate flow is exercised in the event that an incorrect password is provided by the
user:

Adding an external alternate flow
An external alternate flow is an alternate flow that is included from an separate use case.

Alternate flows allow you to demonstrate the behavior of the system, given a particular condition. For example, the
system will behave differently depending on whether the user clicks Yes or No after a confirmation dialog is
displayed.An external alternate flow is the same as an internal alternate flow, except the use case content is stored
in a different (external) use case artifact.

To add an external alternate flow to a use case:

1. Select the use case step where you want the external flow to begin.

In text view, place the cursor on a use case step by clicking anywhere on the use case text.
In workflow view, click a use case step.

2. Click Add Alternate Flow > External .

Choose one of the following options to add an external alternate flow:

Click the Add Alternate Flow drop-down on the ribbon (Use Cases tab, Step group) and then select
External Flow
Click the Add External Flow option on the right-click context menu

After you click the button, the Select Use Case dialog appears.

3. Select the use case you want to add.

1. Search or browse for the use caseuse case diagram.
2. Click OK.

4. Set the start and return steps.

You can use the following buttons to set the start and return steps:

the Set Start/Return Steps button on the ribbon (Use Cases tab, Flow group)
the Set Start/Return Steps option on the right-click context menu

Read more about Setting start and return steps.



©2015 Blueprint Software Systems Inc. All rights reserved 82 of 183

After you have added an alternate flow, a decision point appears in workflow view. In text view, a new flow
appears under the Alternate Flows heading.

In workflow view, you can expand and collapse the alternate flow using the expand and collapse icons. In text
view, you can expand and collapse the alternate flow using the expand and collapse icons.

Note: Alternate flows are labeled the same way in both text view and workflow view. Conditions that are
peers end in letters (example: 2a, 2b, and 2c). The regular steps in the flows end in numbers based on the
condition. Therefore, condition 2a has steps labeled 2a1, 2a2 and so on.

Flow Conditions

The first step in an alternate flow is a condition. Also, the step in the main flow immediately after the decision point
also becomes a condition. The text of the condition steps must indicate under what condition the main flow and
the alternate flow will be exercised.

In the example below, the external flow is exercised in the event that an incorrect password is provided by the
user:

Changing an external use case
An external alternate flow is an alternate flow that is included from an separate use case. If you have added an
external alternate flow to your use case, you can easily change it to a different external use case.

To change an external use case:

1. Select the external use case that you want to change.

In text view, place the cursor anywhere in the text of the external flow.
In workflow view, click a step in the external flow.

2. Click Change External Use Case

Choose one of the following options to add an external flow:

Click the Change External Use Case drop-down on the ribbon (Use Cases tab, Flow group).
Click the Change External Use Case option on the right-click context menu

After you click the button, the Select Use Case dialog appears.

3. Select the use case you want to add.

1. Search or browse for the use caseuse case diagram.
2. Click OK.
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Setting start and return steps
Setting the start and return steps is useful when you want an alternate flow to start from, or return to, a different
step in the use case.

Alternate flows can start from any step in the use case, and can end in any step, the post condition, or exit.

To set the start and return steps:

1. Select an alternate flow.

In text view, place the cursor on the text of an alternate flow.
In workflow view, click a use case step in the alternate flow.

2. Click Set Start/Return Steps.

You can use the following buttons to open the Set Start/Return Steps dialog:

the Set Start/Return Steps button on the ribbon (Use Cases tab, Flow group).
the Set Start/Return Steps option on the right-click context menu.

3. Choose the start and return steps.

Use the drop-down options to set the Start Step and the Return Step. Alternate flows can start
from any step in the use case, and can end in any step, the post condition, or exit.

4. Click OK.

After you have set the start and return steps, the step numbers are updated in text view, and the connectors are
updated in workflow view.

Setting UI mockups on use case steps
A UI Mockup is a prototype of a user interface in the system. UI mockups are effective on a standalone basis, but
are even more powerful when they are viewed in simulations.Associating UI mockups with use case steps
enhances the simulation experience, providing viewers with a richer and clearer understanding of the use case.

To add a UI mockup to a use case step:

1. Select one or more use case step(s) that you want to associate with a UI mockup.

In text view, use your mouse to select the text of one or more use case step(s).
In workflow view, click a use case step. You can select multiple steps in workflow view by holding
the Ctrl key and clicking multiple steps, or by drawing a box around a group of steps.

2. Click Set UI Mockup.

You can use the following buttons to set a UI mockup for use case steps:

the Set UI Mockup button on the ribbon (Use Cases tab, Step group)
the Set UI Mockup option on the right-click context menu

In workflow view, a UI mockup indicator appears in the upper-left corner of the use case step after a UI mockup
has been set. In text view, the UI mockup indicator appears beside the step on the left side. You can click the UI
mockupindicator to view the associated UI mockup.
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Removing a UI mockup from a use case step
A UI Mockup is a prototype of a user interface in the system. UI mockups are effective on a standalone basis, but
are even more powerful when they are viewed in simulations.

When a UI mockup is associated with a use case, a UI mockup indicator appears above the use case step in
workflow view.

Note: You can only remove UI mockups from use case steps one at a time.

To remove a UI mockup from a use case step:

1. Select the use case step that is associated with the UI mockup you want to remove.
In text view, place the cursor on a use case step by clicking anywhere on the use case text.
In workflow view, click a use case step.

2. Click Remove UI Mockup.

Choose one of the following options to remove the UI mockup from the use case step:

Click the Remove UI Mockup button on the ribbon (Use Cases tab, Step group).
Click the Remove UI Mockup option on the right-click context menu.
Click the Remove UI Mockup option that appears when you right-click the UI mockup indicator in
workflow view.

After you have removed the UI mockup, the UI mockup indicator no longer appears above the step in workflow
view.

Deleting a use case

To delete a use case:

1. Open the use case that you want to delete, or select the use case in the artifact list.

To open an artifact, click the artifact ID link that is displayed in the ID column of the artifact list. Or,
right-click the artifact in the artifact list and then click Open.
To select an artifact, click a row in the artifact list.

2. Click Delete.

You can find the Delete button in the following locations:

on the ribbon (Home tab, Artifacts group).
on the context menu when you right-click an artifact in the artifact list.

After you click delete, the Confirmation dialog appears.

3. Confirm the deletion.

Click Yes to confirm deletion, or click No to cancel.
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About use case simulation

Overview
Envisioning what a feature or end product will look like can be challenging when you only have fragmented UI
Mockups and requirements. Simulation can alleviate the issue of having many scattered requirements by
presenting an interactive animation in which all details connect. A simulated use case is a visual animation, like a
movie, that draws attention to the progress of a multi-layered scenario. The Blueprint simulation feature allows you
to develop the relationships between requirements rather than focusing too much on the requirements as
separate entities.

Example

Sam, a business analyst, has been collecting requirements from various stakeholders for an airline
web site. She wants to discover the value her requirements can have together. She has created a
use case that involves a customer checking in online and now she wants to explain the use case
scenario to other stakeholders. In ameeting with developers, Sam walks through each step of the
use case simulation on a projection screen. Starting now, the developers fully comprehend the
functionality they are going to build. The simulation has sparked discussions about build planning,
which propels the developers forward in their project's progress. In another meeting, Sam shows the
use case simulation to sales representatives. One of the sales representatives suggests a piece of
functionality that could be added to the use case, creating discussion about how the new
functionality could better meet customers's needs. For the first time since the project began,
stakeholders are able to understand the project and, as a result, contribute to its success and
completion.

Simulation can help meet the unique needs of various teams. On its most basic level, use case simulation helps
requirement authors explain their feature to stakeholders. Business analysts and developers can "walk through"
simulated use cases together to verify if a feature works. Business analysts and higher management can watch use
case simulations together to see if the functionality aligns with business goals. Simulating a use can help to identify
and eliminate gaps in the requirements and the project as a whole, which is valuable to all stakeholders.

Simulating a use case

Note:Simulations only display changes that you have saved or published. If you need to modify an artifact,
you can make changes to the artifact, save the changes, and then refresh the simulation.

To simulate a use case:

1. Click the ID of the use case artifact you want to simulate.

The use case artifact opens in the main content area.

2. Click the Simulate button (Use Cases tab).

The confirmation dialog appears.

3. Click OK.

The Blueprint Simulate window appears with your Use Case Simulation in the Explorer panel.
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Navigating your Use Case Simulation

Overview
The use case steps appear in the Explorer panel to the left (under Use Case Simulation).

Tip: Click the arrows next to your use case to view the steps in the Use Case Simulation.

Use cases are typically navigated step-by-step, from pre condition (the beginning) to post condition (the end).

However, you can begin the simulation at whichever use case step you prefer. For more information about starting
from a different point, see Navigating your Use Case Simulation.

Navigation markers
The use case step you have currently selected has an orange outline:

When you select a use case, the use case, and all of its steps, become green:

Use case steps you have already viewed are highlighted in the Use Case Simulation:
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Changing the scope of the Use Case Simulation
The scope controls allow you to show any connected external flows and/or included use cases in the simulation.

You can alter the scope of the Use Case Simulation by using the following controls (Home tab, Scope group):

Simulate Related Use Cases (selected by default): when selected, the chain of included use cases is added
to the scope of the simulation. When deselected, only the main use case is simulated.

Use Case Level: allows you to control the degree to which any included use cases and external flows are
shown. You can select a higher number of connected levels to show, or you can select a low number to
hide included use cases.

Note: All levels of included use cases are auto-detected when the Simulate Related Use Cases
check box is selected.

Using the Navigation Controls
To navigate through the Use Case Simulation, use the buttons in the Navigation Controls group (Home tab):

To control the progression of steps, click the Next Step button whenever you want to move to the next
step.

To watch a computerized navigation of the use case, click the Start Automatic Navigation button.

Note: Automatic Navigation stops when it reaches any step that is connected to alternate flows
and requires actor input. For more information about actors interacting with alternate flows, see
Navigating your Use Case Simulation.

To restart the viewing, click the Start Over button at any time.

After clicking Start Over, the orange outline reappears on the first step.

To navigate to the previous use case step, click the Previous Step button.
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Starting the simulation at another step
The use case simulation starts at the pre condition and then progresses sequentially but you can choose to start the
simulation at any step you like.

Note: The Simulate Related Use Cases check box must be selected in order to start the simulation from
any included use case step.

To start a simulation at another step:

Right-click the step you want the simulation to start with and then click Start Simulation from Here.

An orange outline appears around the step, signifying that it is selected. The step details appear in the main
content area.

Actor-system interaction and alternate flows
Blueprint Simulate allows you to test use case steps that require flow selection from an actor. Blueprint Simulate
puts you in the role of the actor, navigating the scenario you have created. You, playing the actor, can choose one
of the available flows in order to progress with the scenario (that is, to progress to the next step).

Example

Sam, a business analyst, wants to simulate a use case that involves checking in online for an airline
flight. To begin the simulation, she clicks the Start Automatic Navigation button. The first use case
step (that is, themain check-in web page displaying all flights) appears for a set number of seconds.
Then, automatically, the next step appears, which requires the customer (actor) to select a flight for
check-in. Sammust select a flight from the list and click the Check In button to progress to the next
step.
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About use case diagrams
Use case diagrams display relationships between use cases and actors in the system.

Tip: To make more space available to view your artifact(s), you can collapse both the utility panel and the
explorer panel by clicking the full screen button (the lower rightmost corner of the window).

Use Case Diagram Artifact Properties
By default, a use case diagram artifact contains the following system properties:

Name: Indicates the name of the use case diagram.
Id: Provides a unique identifier for the use case diagram. The Id cannot be modified.
Type: Indicates the type of artifact.
Width: Indicates the width of the use case diagram, measured in pixels. The maximum size is 7000 pixels.
Height: Indicates the height of the use case diagram, measured in pixels. The maximum size is 7000
pixels.
Show Conditions: Indicates whether or not conditions are shown.

In addition to the default system properties, your project administrator can configure custom properties for each
artifact type.

Adding a use case diagram

To add a use case diagram artifact:

1. Click the New button on the ribbon (Home tab, Artifacts group).
2. Select Child Artifact.

3. Click the use case diagram icon.

Deleting a use case diagram

To delete a use case diagram:

1. Open the use case diagram that you want to delete, or select the use case diagram in the artifact list.

To open an artifact, click the artifact ID link that is displayed in the ID column of the artifact list. Or,
right-click the artifact in the artifact list and then click Open.
To select an artifact, click a row in the artifact list.

2. Click Delete.

You can find the Delete button in the following locations:

on the ribbon (Home tab, Artifacts group).
on the context menu when you right-click an artifact in the artifact list.
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After you click delete, the Confirmation dialog appears.

3. Confirm the deletion.

Click Yes to confirm deletion, or click No to cancel.



©2015 Blueprint Software Systems Inc. All rights reserved 91 of 183

UI mockups
A UI Mockup is a prototype of a user interface in the system. UI mockups are effective on a standalone basis, but
are even more powerful when they are viewed in simulations.

UI Mockup Properties
By default, a UI mockup artifact contains the following system properties:

Name: Indicates the name of the UI mockup.
Id: Provides a unique identifier for the UI mockup. The Id cannot be modified.
Type: Indicates the type of artifact.
Width: Indicates the width of the UI mockup, measured in pixels. The maximum size is 7000 pixels.
Height: Indicates the height of the UI mockup, measured in pixels. The maximum size is 7000 pixels.
Description: Provides a description of the UI mockup.

In addition to the default system properties, your project administrator can configure custom properties for each
artifact type.

Adding a UI mockup

To add a UI mockup artifact:

1. Click the New button on the ribbon (Home tab, Artifacts group).
2. Select Child Artifact.

3. Click the UI mockup icon.

Deleting a UI mockup

To delete a UI mockup:

1. Open the UI mockup that you want to delete, or select the UI mockup in the artifact list.

To open an artifact, click the artifact ID link that is displayed in the ID column of the artifact list. Or,
right-click the artifact in the artifact list and then click Open.
To select an artifact, click a row in the artifact list.

2. Click Delete.

You can find the Delete button in the following locations:

on the ribbon (Home tab, Artifacts group).
on the context menu when you right-click an artifact in the artifact list.

After you click delete, the Confirmation dialog appears.
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3. Confirm the deletion.

Click Yes to confirm deletion, or click No to cancel.

Previewing a UI mockup
Blueprint allows you to preview how your UI mockup would function in a use case simulation. There is no need to
save your UI mockup and then simulate your changes in a use case. You can preview the final product with the click
of a button.

Interactive and non-interactive widgets
UI mockups can contain interactive widgets in addition to non-interactive widgets.

An interactive widget is any UI mockup shape that can be interacted with. For example, you can click an interactive
widget, select options from a widget or type text in a widget.

Example

Jorges, a business analyst, adds a Login button to his UI mockup of an online log-in page. When his
use case is simulated, viewers can click the Login button to go to the next step in the simulation.

A non-interactive widget can fall into one of two categories: shapes that model UI elements, like browsers, and
shapes that call out system behavior. For example, a callout widget can be used to explain a new feature and then
can be hidden on use case steps when the callout does not need to be seen.

Types of interactive widgets include but are not limited to:

Button
Checkbox
Dropdown Button
Dropdown List
Hyperlink
Slider
Text Area
Text Box

There are two ways to interact with UI mockup widgets: launching a simulation of a use case and viewing a preview
of the UI mockup.

To preview your UI mockup:

1. Click the Preview button (UI Mockup tab).

The Preview Mode bar appears at the top of your UI mockup.



©2015 Blueprint Software Systems Inc. All rights reserved 93 of 183

If you have added any interactive widgets, you can test widget functionality similarly to how viewers of a
use case simulation would interact with your UI mockup.

2. To exit Preview mode and return to editing mode, click the Preview button.

About screen captures

Important: This feature is only available if Blueprint is configured to run with elevated in-trust browser.

The Screen Capture feature allows you to quickly and easily take a screen capture of an application running on your
computer and then insert it into a Blueprint artifact. Screen captures are automatically resized to fit the canvas if
the image is too large to fit. Whenever Blueprint resizes screen captures, the aspect ratio is preserved.

Example

Matt, a business analyst, plans tomake some changes to an existing web page. He starts by
creating a new UI mockup artifact. He then uses the screen capture feature to quickly add a screen
capture of the existing web page to the UI mockup. At this point, Matt can take advantage of the UI
mockup widgets to create a rich visual representation of the new user interface.

Applicability

You can add a screen capture to any Blueprint artifact that supports images, including:

UI mockups
Use case diagrams
Generic diagrams



©2015 Blueprint Software Systems Inc. All rights reserved 94 of 183

When the Screen Capture feature is applicable, a Screen Capture button appears on artifact editor contextual

tab on the ribbon. For example, if you open a generic diagram, the Screen Capture button appears on the
ribbon ( Generic Diagram tab, Image group). If you open an actor or document artifact, this button is not available.

Adding a screen capture to an artifact

When you click the Screen Capture button, Blueprint displays a list of all application windows that are open
(but not minimized) on your computer.

To add a screen capture to an artifact:

1. Open the application from which you want to take a screen capture.

2. Leave the application running and switch to Blueprint.

Important: Ensure the application window does not become minimized when you switch to
Blueprint.

3. Open the artifact that you want to add a screen capture to.

The Screen Capture feature is only available in artifacts that support the insertion of images. Refer to the
Applicability section to learn more about support for this feature.

4. Click the Screen Capture button on the ribbon.

The Screen Capture button is located on artifact editor contextual tab (example: Generic Diagram tab)
in the Image group.

After you click the button, the application windows are displayed. If you are using Windows 7, the windows
are displayed as thumbnail images. If you are using an older version of Windows, the windows are displayed
in a list of window titles.

5. Click the application window that you want to capture.

After you click the application window that you want to capture, the screen capture is taken and automatically
inserted into the artifact.
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Business process diagrams
Business process diagram artifacts provide a clear visual representation of requirements involving sequence, flow,
branching, conditions, etc.

Business Process Diagram Artifact Properties
By default, a business process diagram artifact contains the following system properties:

Name: Indicates the name of the business process diagram.
Id: Provides a unique identifier for the business process diagram. The Id cannot be modified.
Type: Indicates the type of artifact.
Width: Indicates the width of the business process diagram, measured in pixels. The maximum size is 7000
pixels.
Height: Indicates the height of the business process diagram, measured in pixels. The maximum size is
7000 pixels.
Description: Provides a description of the business process diagram.

In addition to the default system properties, your project administrator can configure custom properties for each
artifact type.

Adding a business process diagram

To add a business process diagram artifact:

1. Click the New button on the ribbon (Home tab, Artifacts group).
2. Select Child Artifact.

3. Click the business process diagram icon.

Deleting a business process diagram

To delete a business process diagram:

1. Open the business process diagram that you want to delete, or select the business process diagram in the
artifact list.

To open an artifact, click the artifact ID link that is displayed in the ID column of the artifact list. Or,
right-click the artifact in the artifact list and then click Open.
To select an artifact, click a row in the artifact list.

2. Click Delete.

You can find the Delete button in the following locations:
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on the ribbon (Home tab, Artifacts group).
on the context menu when you right-click an artifact in the artifact list.

After you click delete, the Confirmation dialog appears.

3. Confirm the deletion.

Click Yes to confirm deletion, or click No to cancel.
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About Generic Diagrams
A generic diagram refers to a diagram that is created using Blueprint's Generic Diagram Editor. With the Generic
Diagram Editor, you can draw free form diagrams, where the only limitation is your imagination.

Generic diagrams can be used for example to communicate:

Context, scope, boundaries, and system interfaces.
Structure, components, and deployment.
States, sequence, and timing.
Any form of requirement that is not already better expressed using one of the other artifact editors in
Blueprint.

Generic Diagram Artifact Properties
By default, a generic diagram artifact contains the following system properties:

Name: Indicates the name of the generic diagram.
Id: Provides a unique identifier for the generic diagram. The Id cannot be modified.
Type: Indicates the type of artifact.
Width: Indicates the width of the generic diagram, measured in pixels. The maximum size is 7000 pixels.
Height: Indicates the height of the generic diagram, measured in pixels. The maximum size is 7000 pixels.
Description: Provides a description of the generic diagram.

In addition to the default system properties, your project administrator can configure custom properties for each
artifact type.

Adding a generic diagram

To add a generic diagram artifact:

1. Click the New button on the ribbon (Home tab, Artifacts group).
2. Select Child Artifact.

3. Click the generic diagram icon.

Deleting a generic diagram

To delete a generic diagram:

1. Open the generic diagram that you want to delete, or select the generic diagram in the artifact list.

To open an artifact, click the artifact ID link that is displayed in the ID column of the artifact list. Or,
right-click the artifact in the artifact list and then click Open.
To select an artifact, click a row in the artifact list.
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2. Click Delete.

You can find the Delete button in the following locations:

on the ribbon (Home tab, Artifacts group).
on the context menu when you right-click an artifact in the artifact list.

After you click delete, the Confirmation dialog appears.

3. Confirm the deletion.

Click Yes to confirm deletion, or click No to cancel.
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About Storyboards
A storyboard artifact provides a quick way to depict scenarios of a user progressing through the screens of a
system.

Storyboards can show screen sequencing and branching to different screens. Storyboards contain frames, that in
turn can contain UI mockup artifacts. Frames can act as placeholders for future screens, and can also provide
descriptive text of screen content and interaction. Storyboards tend to be used to communicate user interface
requirements at a high level, as opposed to use cases which tend to communicate detailed actor–system
interaction.

Storyboard Artifact Properties
By default, a storyboard artifact contains the following system properties:

Name: Indicates the name of the storyboard.
Id: Provides a unique identifier for the storyboard. The Id cannot be modified.
Type: Indicates the type of artifact.
Width: Indicates the width of the storyboard, measured in pixels. The maximum size is 7000 pixels.
Height: Indicates the height of the storyboard, measured in pixels. The maximum size is 7000 pixels.
Description: Provides a description of the storyboard.

In addition to the default system properties, your project administrator can configure custom properties for each
artifact type.

Adding a storyboard

To add a storyboard artifact:

1. Click the New button on the ribbon (Home tab, Artifacts group).
2. Select Child Artifact.

3. Click the storyboard icon.

Deleting a storyboard

To delete a storyboard:

1. Open the storyboard that you want to delete, or select the storyboard in the artifact list.

To open an artifact, click the artifact ID link that is displayed in the ID column of the artifact list. Or,
right-click the artifact in the artifact list and then click Open.
To select an artifact, click a row in the artifact list.

2. Click Delete.
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You can find the Delete button in the following locations:

on the ribbon (Home tab, Artifacts group).
on the context menu when you right-click an artifact in the artifact list.

After you click delete, the Confirmation dialog appears.

3. Confirm the deletion.

Click Yes to confirm deletion, or click No to cancel.
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About Domain Diagrams
A domain diagram is generally used for problem analysis. A domain diagram shows the major pieces of
information (entities), what they’re composed of (elements), and how the information is related to each other. It
uses relationship notation similar to Entity Relationship Diagrams (ERDs) used to model data schemas. Domain
diagrams are sometimes referred to as domain models, information diagrams, information models, or conceptual
data models.

Domain Diagram Artifact Properties
By default, a domain diagram artifact contains the following system properties:

Name: Indicates the name of the domain diagram.
Id: Provides a unique identifier for the domain diagram. The Id cannot be modified.
Type: Indicates the type of artifact.
Width: Indicates the width of the domain diagram, measured in pixels. The maximum size is 7000 pixels.
Height: Indicates the height of the domain diagram, measured in pixels. The maximum size is 7000 pixels.
Description: Provides a description of the domain diagram.

In addition to the default system properties, your project administrator can configure custom properties for each
artifact type.

Adding a domain diagram

To add a domain diagram artifact:

1. Click the New button on the ribbon (Home tab, Artifacts group).
2. Select Child Artifact.

3. Click the domain diagram icon.

Deleting a domain diagram

To delete a domain diagram:

1. Open the domain diagram that you want to delete, or select the domain diagram in the artifact list.

To open an artifact, click the artifact ID link that is displayed in the ID column of the artifact list. Or,
right-click the artifact in the artifact list and then click Open.
To select an artifact, click a row in the artifact list.

2. Click Delete.

You can find the Delete button in the following locations:
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on the ribbon (Home tab, Artifacts group).
on the context menu when you right-click an artifact in the artifact list.

After you click delete, the Confirmation dialog appears.

3. Confirm the deletion.

Click Yes to confirm deletion, or click No to cancel.
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Document artifacts
A document artifact allows you to upload a file and then reference that file from multiple artifacts.

Document artifacts are different than file attachments. Document artifacts can be referenced from multiple
artifacts by adding it as a document reference to other artifacts in the utility panel files tab. File attachments are
also added in the files tab of the utility panel and are associated with a single artifact. Refer to File attachments and
document references for more information.

Example

Pauline, a regulatory analyst, has asked business analysts to adhere to a number of standards while
gathering requirements for the system. She creates a new document artifact and uploads the
standards document to the artifact.

Gabrielle, a business analyst, modifies a use case so it adheres to the applicable standards. She
adds a document reference to her use case artifact so other users will understand the rationale for the
changes. She also adds a comment to the use case artifact to explain the reason for the
modifications.

Document Artifact Properties
By default, a document artifact contains the following system properties:

Name: Indicates the name of the document.
Id: Provides a unique identifier for the document. The Id cannot be modified.
Type: Indicates the type of artifact.
Description: Provides a description of the document.
File: Provides the name of the uploaded file.

In addition to the default system properties, your project administrator can configure custom properties for each
artifact type.

Adding a document artifact
A document artifact allows you to upload a file and then reference that file from multiple artifacts.

To add a document artifact:

1. Click the New button on the ribbon (Home tab, Artifacts group).
2. Select Child Artifact.

3. Click the document icon.

After you have added a new document artifact, you will probably want to upload a file.
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Uploading a file to a document artifact
A document artifact allows you to upload a file and then reference that file from multiple artifacts.

After you create a document artifact, you can upload a document file to the artifact. Each document artifact can
contain a single document file. However, if a file already exists, you can upload a new file to replace the existing
file. You can also use the files tab in the utility panel to upload multiple file attachments and document references
to a document artifact.

1. Open a document artifact.

Click the artifact ID link of the artifact you want to open.

2. Click Attach a File or Replace.

The Attach a File link is only displayed if a file has not yet been uploaded. The Replace link appears after a
user has uploaded a file. The Replace link allows you to upload a new file to replace the existing file. After
you click one of the links, the Open dialog appears.

3. Select the file you want to upload and then click Open.

By default, the file selection window only displays DOCx Files (.docx) files. To select a different file type,
click the drop-down and select a different type, or select All files.

4. Save or publish your changes to upload the file.

The file is uploaded from your computer to Blueprint. This may take some time depending on the size of the
file you are uploading.

Note: Blueprint enforces a maximum file size for document uploads. The maximum file size is
configurable by your project administrators.

Note: You must publish the artifact before your changes are viewable by other users.

After you upload a document file, you may want to add a textual summary of the file to the Description field.
The document artifact Name is automatically replaced with the name of the document you uploaded, but Blueprint
allows you to change the name, if required. The File field is also replaced with the name of the document, but
you cannot change this value unless you rename the file on your computer and upload it again.

After you upload a file, you can click the Download link to download or open the file. You can also click Replace to
upload a new file to replace the existing file:

Note: If you are using Internet Explorer 8, you must enable the automatic prompting for file downloads
security setting before you can download the file from Blueprint. To enable this setting, click Tools >
Internet Options > Security > Custom level... > Downloads and then enable the Automatic prompting
for file downloads option.
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Deleting a document artifact

To delete a document:

1. Open the document that you want to delete, or select the document in the artifact list.

To open an artifact, click the artifact ID link that is displayed in the ID column of the artifact list. Or,
right-click the artifact in the artifact list and then click Open.
To select an artifact, click a row in the artifact list.

2. Click Delete.

You can find the Delete button in the following locations:

on the ribbon (Home tab, Artifacts group).
on the context menu when you right-click an artifact in the artifact list.

After you click delete, the Confirmation dialog appears.

3. Confirm the deletion.

Click Yes to confirm deletion, or click No to cancel.
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Glossary artifacts
A glossary artifact is a compilation of terms and definitions. Glossary terms can be linked from other artifacts,
providing readers with easy access to definitions.

Maintaining a glossary is one of the simplest ways to reduce misunderstanding by encouraging project members to
use a common vocabulary. Blueprint allows you to create multiple glossaries. You can then merge terms between
glossaries to create a repository of common words. Blueprint's glossary artifact provides you with an easy way to
manage and reference definitions for acronyms, business terms, and technical terms.

Glossary Artifact Properties
By default, a glossary artifact contains the following system properties:

Name: Indicates the name of the glossary.
Id: Provides a unique identifier for the glossary. The Id cannot be modified.
Type: Indicates the type of artifact.
Description: Provides a description of the glossary.

In addition to the default system properties, your project administrator can configure custom properties for each
artifact type.

Adding a glossary

To add a glossary artifact:

1. Click the New button on the ribbon (Home tab, Artifacts group).
2. Select Child Artifact.

3. Click the glossary icon.

Deleting a glossary

Note: If you delete a glossary, all terms that are linked from other artifacts will continue to reference a
read-only version of the glossary.

To delete a glossary:

1. Open the glossary that you want to delete, or select the glossary in the artifact list.

To open an artifact, click the artifact ID link that is displayed in the ID column of the artifact list. Or,
right-click the artifact in the artifact list and then click Open.
To select an artifact, click a row in the artifact list.

2. Click Delete.
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You can find the Delete button in the following locations:

on the ribbon (Home tab, Artifacts group).
on the context menu when you right-click an artifact in the artifact list.

After you click delete, the Confirmation dialog appears.

3. Confirm the deletion.

Click Yes to confirm deletion, or click No to cancel.

Adding a new term directly to the glossary

1. Open a glossary artifact.
2. Right-click and select Add Term. A new row appears in the table.

3. Type the name of the term and definition into the Term and Definition columns.
The terms and definitions are now sub-artifacts of the glossary.

Adding a new glossary term from another artifact
You can easily add a new term to a glossary while working on any artifact in the system.

Notes

When you use the Add to Glossary feature, the term is added to the glossary, but a link to the glossary
term is not automatically included in the artifact that you are working on.

After the new term is added, you still have to edit the glossary to provide a definition for the term.

To add a new glossary term while working on another artifact:

1. Highlight the text that you want to add as a term to the glossary.
2. Click Add to Glossary.

1. right-click and select Add to Glossary.

The Add to Glossary dialog appears.

3. Select the glossary you want to contain the new term.

1. Search or browse for the glossary.
2. Click OK.

A dialog appears to notify you that the term was added successfully.

After you have added the new glossary term, you may want to link the term to some text in your artifact. You may
also want to edit the glossary term to provide a definition for the new term.

Linking to an existing glossary term from other artifacts
Linking to a glossary term is referred to as a glossary reference. After you have created a glossary reference, you
can point to the terms to view the definition inline.
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1. Open the artifact and highlight the text that you want to link to a glossary term.
2. Click Add Glossary Reference.

1. Right-click and select the Add Glossary Reference option.

The Add Glossary Reference dialog appears.

3. Select the glossary term.

1. Search or browse for the glossary term.
2. Click OK.

After you have added a glossary reference, the term is displayed as a link. If you hover on the link, the definition is
displayed as follows:

Editing a glossary term

1. Open the glossary that contains the term that you want to edit.
2. Double-click the term or definition that you want to edit. Edit mode is now activated, allowing you to make

changes to the existing content.

Deleting a glossary term

Note: After you delete a glossary term, the definition is no longer available from any artifacts that are
linked to the term.

1. Open the glossary artifact that contains the term you want to delete.
2. Right-click the term you want to delete and select Remove Term.
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Baselines and reviews
A baseline artifact is a snapshot in time of one or more artifacts in a project. Baselines provide you with a reference
point for viewing project artifacts as they existed at a particular point in time, even after the artifacts have changed.
Baseline artifacts can be included in reviews to obtain feedback and approval.

A review artifact allows you to request artifact feedback and/or approval from stakeholders. Review artifacts can be
set to one of two types: informal review (live artifacts), or formal review (baseline artifacts). You can only request
approval or electronic signatures on artifacts if they are included in a formal review. If you create an informal
review, review participants can add comments to artifacts, but the artifacts cannot be approved.

Note: A baseline must be sealed and published before you can include it in the review contents. This
ensures that the artifacts do not change while the review is underway.

Finding your baseline and review artifacts
Baseline and review artifacts are special artifacts that are treated somewhat differently than other artifacts in
Blueprint. Baseline and review artifacts are stored in a separate location in Blueprint. You can find your project's
baseline and review artifacts by clicking the Baselines and Reviews folder located below your project in the
explorer panel of Blueprint:

After you click the Baselines and Reviews folder for your project, your baseline and review artifacts are displayed
in the main content area.

Reviewer and Approver Roles in Formal and Informal Reviews

A review artifact can be set to either a formal review or an informal review. Formal reviews contain sealed baseline
artifacts, while informal reviews contain live artifacts.

In a formal review (that is, sealed baseline artifacts), both reviewers and approvers have the ability to add
comments to the artifacts. Approvers also have the ability to approve or disapprove artifacts. If the
electronic signature option is enabled, approvers must verify their approvals/disapprovals via password or
federated authentication. Reviewers cannot approve or disapprove artifacts.
In an informal review (that is, live artifacts), both reviewers and approvers have the ability add comments to
the artifacts. Reviewers cannot approve/disapprove artifacts in an informal review.



©2015 Blueprint Software Systems Inc. All rights reserved 110 of 183

Baseline and Review Examples

Example

Lewis, a business analyst, is working on a set of requirements. He is close to completion and would
like to obtain feedback from a few individuals.

In this scenario, Lewis would create an Informal Review, which is a review containing live artifacts.
Lewis can continue to change the artifacts, and reviewers will always see themost recent published
artifact when they open the artifacts from the review.

Example

Susan, a business analyst, is finished incorporating feedback from prior reviews that she has
conducted. She is now confident that her artifacts are ready for approval.

In this scenario, Susan creates a baseline artifact. Next, she creates a review artifact and sets the
type to Formal Review. Susan can then select the stakeholders that she wants to approve the
requirements.

Example

Bill, a business analyst, is seeking approval on a complex use case artifact. In order to understand
the use case, there are a number of textual requirements that must first be understood.

In this scenario, Bill starts by creating a baseline artifact. He then creates a Formal review, and
includes the use case and the textual requirements in the review content. Bill only places a
checkmark beside the use case artifact, because this is the only artifact that he needs approved.
Readmore about selecting the artifacts that require approval.

The review participants now have the ability to review the textual requirements, and then approve or
disapprove of the use case.

Example

Laura, a user experience designer, has completed her first draft of UI mockups. She would like to
obtain feedback from numerous individuals, but is only seeking approval from a select few.

In this scenario, Laura creates a baseline artifact. She then creates a Formal review and adds the
UI mockup artifacts to the review contents. Laura selects all individuals from the list, and then
changes the Permissions for each individual to either Reviewer or Approver.

About Baselines
A baseline artifact is a snapshot in time of one or more artifacts in a project. Baselines provide you with a reference
point for viewing project artifacts as they existed at a particular point in time, even after the artifacts have changed.
Baseline artifacts can be included in reviews to obtain feedback and approval.

Baselines can be sealed or unsealed:

A sealed baseline contains a timestamp and contents that can no longer be modified. Sealing a baseline is a
manual action performed by a user and once sealed, a baseline can never be unsealed. Only artifacts in
sealed baselines can be Approved as part of a review.
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When a baseline is unsealed, you are able to modify the contents. While artifacts in an unsealed baseline
can be viewed and commented on as part of a review, they cannot be Approved.

Finding your baseline artifacts

Baseline artifacts are special artifacts that are treated somewhat differently than other artifacts in Blueprint.
Baseline artifacts are stored in a separate location in Blueprint.

You can find your project's baseline and review artifacts by clicking the Baselines and Reviews folder located
below your project in the explorer panel of Blueprint:

Typical Baseline Usage

Baselines are typically created as you reach a milestone in the project. Baselines ensure that you can view the
artifacts as they existed at a particular moment in time.

If you need a record of artifacts at a particular moment in time (for any reason):

1. Create a new baseline artifact.
2. Configure and seal the baseline artifact.
3. If artifacts are ready to be reviewed and approved, you can add a review and configure the review to

include the baseline in the review contents.

Baseline Artifact Properties

By default, a baseline artifact contains the following system properties:

Name: Indicates the name of the baseline.
Id: Provides a unique identifier for the baseline. The Id cannot be modified.
Type: Indicates the type of artifact.
Sealed: Indicates whether or not the artifact is sealed. This property can be Yes or No. When a baseline
artifact is sealed, you can no longer change the baseline contents.
Description: Provides a description of the baseline.

In addition to the default system properties, your project administrator can configure custom properties for each
artifact type.

Creating a new baseline
A baseline artifact is a snapshot in time of one or more artifacts in a project. Baselines provide you with a reference
point for viewing project artifacts as they existed at a particular point in time, even after the artifacts have changed.
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Baseline artifacts can be included in reviews to obtain feedback and approval.

You can create a baseline within the Baselines and Reviews folder or you can add artifacts to a new baseline within
the artifact list. For more information on the latter topic, see Adding an artifact to a baseline.

To add a baseline artifact:

1. Click the Baselines and Reviewsfolder in the explorer panel.

2. Click the New button on the ribbon (Home tab, Artifacts group).
3. Select Child Artifact.

4. Click the baseline icon.

Next, you will probably want to configure and seal the baseline. Read more about Configuring and sealing a
baseline

Configuring and sealing a baseline
After you have created a new baseline or added artifacts to a baseline, you must configure a few settings before
you can seal the baseline.

Baselines can be sealed or unsealed:

A sealed baseline contains a timestamp and contents that can no longer be modified. Sealing a baseline is a
manual action performed by a user and once sealed, a baseline can never be unsealed. Only artifacts in
sealed baselines can be Approved as part of a review.

When a baseline is unsealed, you are able to modify the contents. While artifacts in an unsealed baseline
can be viewed and commented on as part of a review, they cannot be Approved.

To configure and seal a baseline:

1. Provide a name for the baseline artifact.

Type a name into the Name field.

Tip: We recommend that you choose a name that is descriptive, but relatively short in length.

2. Set the baseline timestamp.
1. Click the calendar button and select the desired date and time, or click the Live button to

reference the live versions of the artifacts.
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Note:

After you save the baseline artifact with a time stamp, the baseline will reference the
artifacts as they existed at that particular day and time.

If the Timestamp is set to Live Artifacts, the baseline contents will always reference the
most up-to-date (live) versions, until the baseline is sealed. If the Timestamp is set to Live
Artifactswhen you seal the baseline, the Timestamp is automatically updated with the
current date and time, and the baseline will always reference the versions as they existed
at that date and time.

2. Click Close to close the calendar.

3. Provide a description for the baseline.

1. Type a description into the Description field.

The description can be used for any purpose, but it is typically used to provide information about the
purpose of the artifact.

4. Choose the artifacts to include in the baseline.

1. Click the Select Baseline Content button. The Select Baseline Content dialog appears. By default, all
artifacts are added to the Baseline Contents section on the right side of the dialog.

2. Use the Add and Remove buttons to move all of the desired artifacts to the right side of the dialog.
3. Click OK to save the baseline contents.

Note: If any of the selected artifacts are currently being edited, a warning is displayed. The
options are Continue,OK, or Cancel. Click the Continue button to select the content with
the unsaved versions of the artifact. Click the OK button to close the dialog. Click the Cancel
button to completely cancel the content selection.

5. Seal the baseline.

1. Click the Seal Baseline button to seal the baseline.

Viewing baseline contents
The purpose of creating a baseline is to gain the ability to view artifacts as they existed a particular moment in time.

Note: Baseline contents are read-only and cannot be modified.

To view baseline contents:

1. Click the Baselines and Reviews folder in the explorer panel.

You can find your project's baseline and review artifacts by clicking the Baselines and Reviews folder
located below your project in the explorer panel of Blueprint:
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2. Open the baseline artifact that contains the baseline contents that you want to view.
The baseline contents appear in the main content area.

Deleting a baseline

Note: You cannot delete baseline artifacts that are sealed.

Tip: Consider creating folders to organize your baseline artifacts. For example, you may want to create a
folder named Archive to store the artifacts that you used for testing, or those that you no longer need.

To delete a baseline:

1. Open the baseline that you want to delete, or select the baseline in the artifact list.

To open an artifact, click the artifact ID link that is displayed in the ID column of the artifact list. Or,
right-click the artifact in the artifact list and then click Open.
To select an artifact, click a row in the artifact list.

2. Click Delete.

You can find the Delete button in the following locations:

on the ribbon (Home tab, Artifacts group).
on the context menu when you right-click an artifact in the artifact list.

After you click delete, the Confirmation dialog appears.

3. Confirm the deletion.

Click Yes to confirm deletion, or click No to cancel.

Adding an artifact to a baseline
Blueprint allows you to conveniently add one or more artifacts to a baseline without leaving your artifact list.
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You can also create a new baseline for your selected artifact within the same operation.

Alternatively, you can create a baseline from within the Baselines and Reviews folder (Explorer Panel). For more
information about creating a baseline, see Creating a new baseline.

Adding an artifact to a baseline

To add an artifact to a baseline:

1. Select the artifacts in your artifact list that you want to add to a baseline.

You can also add a single artifact to a baseline when the artifact editor is open.

2. Click the Add To button on the ribbon and then click Baseline (Home tab, Artifacts group).

The Add to Baseline(s) dialog box appears.

Tip: To add all of the contents of any selected folder(s), select the Add all children of the selected
artifact(s) to the baseline(s) check box.

3. Select your baseline(s) and then click OK.

To create a new baseline, click Create Baseline.

The baseline(s) appear(s) with your included artifacts.

Next, you will probably want to configure and seal the baseline. Read more about Configuring and sealing a
baseline

About Reviews
A review artifact allows you to request artifact feedback and/or approval from stakeholders. Review artifacts can be
set to one of two types: informal review (live artifacts), or formal review (baseline artifacts). You can only request
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approval or electronic signatures on artifacts if they are included in a formal review. If you create an informal
review, review participants can add comments to artifacts, but the artifacts cannot be approved.

Note: A baseline must be sealed and published before you can include it in the review contents. This
ensures that the artifacts do not change while the review is underway.

When the review is active, you can view the review status information to determine which individuals have started
reviewing the artifacts and whether or not any of the artifacts have been approved.

Finding your review artifacts

Review artifacts are special artifacts that are treated somewhat differently than other artifacts in Blueprint. Review
artifacts are stored in a separate location in Blueprint. You can find your project's baseline and review artifacts by
clicking the Baselines and Reviews folder located below your project in the explorer panel of Blueprint:

After you click the Baselines and Reviews folder for your project, your baseline and review artifacts are displayed
in the main content area.

Key Concepts

Reviewer and Approver Roles in Formal and Informal Reviews

A review artifact can be set to either a formal review or an informal review. Formal reviews contain sealed baseline
artifacts, while informal reviews contain live artifacts.

In a formal review (that is, sealed baseline artifacts), both reviewers and approvers have the ability to add
comments to the artifacts. Approvers also have the ability to approve or disapprove artifacts. If the
electronic signature option is enabled, approvers must verify their approvals/disapprovals via password or
federated authentication. Reviewers cannot approve or disapprove artifacts.
In an informal review (that is, live artifacts), both reviewers and approvers have the ability add comments to
the artifacts. Reviewers cannot approve/disapprove artifacts in an informal review.

Review Status

The review can have one of the following statuses:

Draft: The review has not yet been distributed to reviewers and approvers.
Active: Reviewers and approvers have been notified about the review. Reviewers and approvers can view
and comment on the review contents. Approvers can also approve or disapprove of review contents.
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Closed: Reviewers and approvers can no longer comment on the review contents after the review is closed.
Approvers can no longer approve or disapprove the review contents.

Modifying an Active Review

When any review is active, you can still modify the list of review participants. Your ability to change other review
parameters differs depending on whether you are modifying an Informal Review (live artifacts) or a Formal Review
(baseline artifacts). The differences are:

When an informal review is active, you can modify the review participants and change the review contents,
but you cannot change the review to include baseline contents.
When a formal review is active, you can modify the review participants and their approval permissions. You
can also modify which artifacts are candidates for approval. You cannot, however, change the review
content to include a different baseline.

Typical Usage of Reviews

Review artifacts can be beneficial at any phase in the project when you want to elicit feedback from others. Here's
an example:

Example

Lewis, a business analyst, is working on a set of requirements. He is close to completion and would
like to obtain feedback from a few individuals.

In this scenario, Lewis would create an Informal Review, which is a review containing live artifacts.
Lewis can continue to change the artifacts, and reviewers will always see themost recent published
artifact when they open the artifacts from the review.

Review artifacts are also useful when requirements are complete and final approval is required. Here's an
example:

Example

Susan, a business analyst, is finished incorporating feedback from prior reviews that she has
conducted. She is now confident that her artifacts are ready for approval.

In this scenario, Susan creates a baseline artifact. Next, she creates a review artifact and sets the
type to Formal Review. Susan can then select the stakeholders that she wants to approve the
requirements.

Review Artifact Properties

By default, a review artifact contains the following system properties:

Name: Indicates the name of the review.
Id: Provides a unique identifier for the review. The Id cannot be modified.
Type: Indicates the type of artifact.
EndDate: Indicates the review deadline date.
ReviewType: Indicates whether the review is formal or informal.
ReviewURL: Indicates the URL to access the review.
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Status: Indicates the status of the review.

The review can have one of the following statuses:

Draft: The review has not yet been distributed to reviewers and approvers.
Active: Reviewers and approvers have been notified about the review. Reviewers and approvers
can view and comment on the review contents. Approvers can also approve or disapprove of
review contents.
Closed: Reviewers and approvers can no longer comment on the review contents after the review is
closed. Approvers can no longer approve or disapprove the review contents.

Description: Provides a description of the review.
In addition to the default system properties, your project administrator can configure custom properties for each
artifact type.

Adding a review
This topic shows you how to add a review within the Baselines and Reviews folder.

Alternately, you can add a review using the Add to Review button without leaving your open artifact or artifact list.
For more information about adding a review with the Add to Review button, see Adding artifacts to an existing
review

To add a new review artifact:

1. Click the Baselines and Reviews folder in the explorer panel.

2. Click the New button on the ribbon (Home tab, Artifacts group).
3. Select Child Artifact.

4. Click the review icon.

Configuring a review

To configure a review, perform the following steps:

1. Provide a name for the review artifact.

Type a name into the Name field.
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Tip: We recommend that you choose a name that is descriptive, but relatively short in length.

2. Set the review end date.

1. Click the calendar button and select the date. Or, type the date into the field in the following
format: MM/DD/YYYY (example: 11/14/2011).

Note: The review does not automatically close when the End Date is reached. The end date is a
simple request for review participants to complete the review by a particular date.

3. Set the review contents.

1. Click the Select Contents and Approval Button. The Choose review contents dialog appears.
2. Select Formal Review or Informal Review. Formal reviews allow your collaborators to view,

comment, and approve/disapprove artifacts in a sealed and published baseline. Informal reviews
allow your collaborators to view and comment on live artifacts in the review.

Note: You must select your desired option prior to selecting the review contents. If you
change this option after review contents have been selected, you will receive a warning
and you must discard the selected review contents prior to continuing.

3. Search or browse to select the artifacts that you want to include in the review, and then move them
to the right side of the dialog underReview Contents.

Tip: To select all child artifacts in a folder, select the folder and then click Add Children.
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Note:If theDo not count folders in the total number of artifacts to reviewcheck box is
selected, folders are not counted as artifacts in the review. The total number of viewed
artifacts is displayed in View Overviewand theReviewers Experience.

4. If you have selected a Formal Review, place a checkmark beside all the artifacts that you are seeking
approval.

Tip: To select all artifacts in a folder, select the folder and then click Select All.

Note: Artifacts that appear on the right side of the dialog without a checkmark can be
reviewed, but not approved.

5. Click OK to save the review contents.
4. Set the reviewers:

1. Click the Select Review Participants button.
2. Place a checkmark beside the appropriate individuals.
3. Click OK to save the review participants.

5. Provide a description for the review.

1. Type a description into the Description field.

The description can be used for any purpose, but it is typically used to provide information about the
purpose of the artifact.

6. Start the review.

Choose one of the following options for starting the review:

Click the Start Review button in the main content area when the review artifact is open.

Click the Start button located on the ribbon (Baselines and Reviews tab, Review group).
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Note: The Start Review button cannot be selected until there is at least one artifact added to the
review contents.

After you start the review, the Status changes to Active, and review participants are sent an email notification
about the pending review request.

Note: Review artifacts are automatically published after you change the status of the review.

MODIFYING AN ACTIVE REVIEW

When any review is active, you can still modify the list of review participants. Your ability to change other review
parameters differs depending on whether you are modifying an Informal Review (live artifacts) or a Formal Review
(baseline artifacts). The differences are:

When an informal review is active, you can modify the review participants and change the review contents,
but you cannot change the review to include baseline contents.
When a formal review is active, you can modify the review participants and their approval permissions. You
can also modify which artifacts are candidates for approval. You cannot, however, change the review
content to include a different baseline.

Adding artifacts to an existing review
Blueprint allows you to conveniently add one or more artifacts to an existing informal review without leaving your
artifact list.

You can also create any type of review and add artifacts to it within the Baselines and Reviews folder (Explorer
Panel). For more information about creating a review, see Adding a review and Configuring a review.

To add an artifact to an informal review:

1. Select the artifacts in your artifact list that you want to add to an informal review.

Important: Individually select each artifact you want to include in the informal review. Selecting a
folder does not automatically select all of its child artifacts for inclusion in the review.

You can also add a single artifact to a review when the artifact editor is open.

2. Click the Add To button on the ribbon and then click Review (Home tab, Artifacts group).
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The Add to Review dialog box appears.

3. Select your review(s) and then click OK.

The Confirmation dialog box appears.

Click OK.

Your artifact(s) have been added to your selected review(s).

Next, you will probably want to configure the review. For more information about configuring the review, see
Configuring a review.

Viewing review status information
After you have started a review, the Review Status is set to Active. At this point, you may wish to view status
information so you can determine which review participants have started viewing the review contents, and
whether or not the artifacts have been approved, disapproved, or not yet specified. In addition to viewing status
information for active reviews, you can also view review status information for Closed reviews.

To view the review status information:

1. Open the review artifact.
2. Click the View Overview / View Details toggle link to view the review status in either the detailed or

overview layout. The two different layouts are explained below.

Overview Layout

Note:If you selected theDo not count folders in the total number of artifacts to reviewcheck box during
the creation of the review, folders are not counted as artifacts in the review. As a result, folders are not
counted in the total number of viewed artifacts.

The Overview layout provides a graphical representation of the review status.

The Contents chart provides:

number of viewed artifacts:
the number of artifacts that have been viewed by all review participants
the number of artifacts that have been viewed no review participants, or only some review
participants

number of artifacts by approval status:
number of artifacts that have been Approved by all review participants
number of artifacts that have been Disapproved by all review participants
number of artifacts that have at least one Pending Approval status
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The Review Participantschart provides:

the total number of review participants in each stage of the review (Complete, In Progress and Not Started).
the total number of Approved, Disapproved and Pending Approval artifacts by review participant

Details Layout

The Details layout provides detailed numerical status information about the review.

CONTENTS TABLE

The Contents table provides a breakdown, by artifact, of the total number of Approved, Disapproved, and Not
Specified statuses. The Approval column is set to Not Requested if approval was not requested for that particular
artifact.
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To view the approval status for an individual artifact, select the artifact in the contents table, and click the View
Detailslink located below the table. The contentsView Details dialog looks like this:

REVIEWER PARTICIPANTS TABLE

The Review Participants table provides the following information about the participants in your review:

Permissions: Provides the review permissions of each individual. All review participants have permissions to
review artifacts. If a user has Approver permissions, the user can approve or disapprove artifacts. Approver
permissions can only be assigned in a formal review. The permissions can be set to Reviewer or Approver.
Status: Provides the review status of the individual. The status can be set to Not Started, In Progress, or
Completed.
Approval: Provides the approval status for each individual. The Approvalcolumn provides the total number
of Approved, Disapproved, and Pending Approval artifacts for each individual.
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To view the approval progress of an individual, select the individual in the review participants table, and click the
View Detailslink located below the table. The review participantsView Detailsdialog looks like this:

Closing a review
The purpose of closing a review is to prevent review participants from adding additional comments to artifacts in
the review. It also prevents review participants from changing the approval status of artifacts.

Note: After a review is closed, it cannot be changed back to an active status.

To close a review:

1. Open the review artifact that you want to close.
2. Click Close Review.

Choose one of the following options for closing the review:

Click the Close Review button in the main content area when the review artifact is open.

Click the Close button located on the ribbon (Baselines and Reviews tab, Review group).

Note: Review artifacts are automatically published after you change the status of the review.

Reviewers and approvers can no longer comment on the review contents after the review is closed. Approvers can
no longer approve or disapprove the review contents.
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Creating a follow up review
Using a follow up review, you can quickly create a new review artifact based on an existing closed review with the
same review contents and the same review participants. The review participants view state and approvals are
carried over into the new review. The author of the review can modify the contents and review participants, if
desired.Follow up reviews are beneficial for many reasons. For instance, after you have incorporated stakeholder
feedback from a previous review, you may wish to send the same review contents for an additional review, to the
same list of stakeholders.

Note: You can only create follow up reviews for reviews that are closed.

To create a follow up review:

1. Open the review artifact that you want to follow up on.
2. Click Follow Up.

The Follow Up button is located on the ribbon (Baselines and Reviews tab, Review group).

After you click Follow Up, the Confirmation dialog appears.

3. Click Yes to confirm that you want to create a follow up review.

A new review artifact is created with the same review contents and review participants. The name of the
new review artifact is the same, but follow-up is appended to the end of the name.

4. Configure and start the follow up review. Read more about configuring a review.

Deleting a review

Note: Review artifacts cannot be deleted if the Review Status is Active or Closed. You can only delete
Draft review artifacts.

Tip: Consider creating folders to organize your review artifacts. For example, you may want to create a
folder named Archive to store the artifacts that you used for testing, or those that you no longer need.

To delete a review:

1. Open the review that you want to delete, or select the review in the artifact list.

To open an artifact, click the artifact ID link that is displayed in the ID column of the artifact list. Or,
right-click the artifact in the artifact list and then click Open.
To select an artifact, click a row in the artifact list.

2. Click Delete.

You can find the Delete button in the following locations:

on the ribbon (Home tab, Artifacts group).
on the context menu when you right-click an artifact in the artifact list.

After you click delete, the Confirmation dialog appears.
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3. Confirm the deletion.

Click Yes to confirm deletion, or click No to cancel.

About the utility panel reviews tab
The reviews tab provides you with a list of all reviews that contain the artifact. From this tab, you can view summary
information about the reviews, or open the review for additional details.

The reviews tab in the utility panel looks like this:

A label is displayed at the top of every tab in the utility panel. It provides the ID and name of the artifact or sub-
artifact you are viewing. For example:

Understanding the review summary table

The top portion of the reviews tab displays a table of information with the following columns:

Review Packages: Provides the name of the review.

Tip: You can click the review link to open the review in the main content area.

Status: Indicates the status of the review. Read more about review status.
Approval: Indicates the total number of artifacts that are approved, disapproved, or not yet specified. This
column displays N/A if approvals were not requested (example: informal reviews).
Created Date: Indicates the creation date of the review. This date provides the date the review artifact was
created, which is not always the same date the artifact became active.
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Understanding the review details

The review details are displayed at the bottom of the reviews tab in the utility panel as soon as a review is selected.

The review summary details panel is labeled with the review ID and name. Example

To view additional details about the changes, simply expand and collapse the headings (example: Details, Review
Participants View State) to view more details about the review.

About the Reviewers Experience
The Reviewers Experience refers to the user interface used by review participants. This is a very simple yet
powerful interface designed specifically for supporting review participant tasks.

Artifacts included in a review can have one of the following status values:

Not Specified: You have not yet approved or disapproved the artifact.
Approved: You have approved the artifact.
Disapproved: You have disapproved the artifact.
Custom status

Note: Each custom status must have a type of either Approved or Disapproved
(example: Approved with Comments)

A Typical Review Process

A typical review process happens as follows. The review participant will:

1. Open the review.
2. View the contents of each artifact.
3. Provide feedback by adding new comments and replying to existing comments.
4. Approve or disapprove each artifact.
5. Change your review status to completed.

Note: All artifacts in a review are read-only in the Reviewers Experience. Live artifacts may be changed
during the review (but not using the Reviewers Experience) while baseline artifacts cannot be changed.
However, you can use the New Comment button on the ribbon (Home tab, Artifact group) to add a
comment to any artifact in the review package. When you click the New Comment button, the
Discussions tab is automatically opened in the utility panel.

About the reviewers experience layout
The Reviewers Experience refers to the user interface used by review participants. This is a very simple yet
powerful interface designed specifically for supporting review participant tasks. The Reviewers Experience layout is
similar to the general Blueprint layout, with a few exceptions:

there is no explorer panel
the ribbon tabs, groups and buttons differ
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The Reviewers Experience looks like this:

When you first open a review in the review experience, the following information is displayed in the main content
area:

Properties:
Name: Indicates the name of the review artifact.
Status: Indicates the status of the review.

The review can have one of the following statuses:

Draft: The review has not yet been distributed to reviewers and approvers.
Active: Reviewers and approvers have been notified about the review. Reviewers and
approvers can view and comment on the review contents. Approvers can also approve or
disapprove of review contents.
Closed: Reviewers and approvers can no longer comment on the review contents after the
review is closed. Approvers can no longer approve or disapprove the review contents.

Note: Draft reviews cannot be opened in the Reviewers Experience.

ID: Indicates the ID of the review.
Permissions: Indicates the reviewer participant permission level:

Approver: Indicates that you are an approver, and therefore you can approve or disapprove
the artifacts. You can also add comments to the review contents.
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Reviewer: Indicates that you are a reviewer, and therefore you can add comments to the
review contents, but you cannot approve or disapprove artifacts in the review.

End Date: Indicates the end date of the review.

Note: The review does not automatically close when the End Date is reached. The end
date is a simple request for review participants to complete the review by a particular
date.

Your Status:
Your Status: Provides the review coordinator with information about the progress of each
stakeholder. Your Status can be set to one of the following:

Not Started: Indicates that you have not yet started reviewing the contents.
In Progress: Indicates that your review is in progress. The status is automatically set to In
Progress as soon as you open the review contents.
Completed: Indicates that you have set your review status to Completed. You must perform
this action manually.

you might want to mention that all these states are visible to the author of the user and are used by
them to know the progress of the review

Complete the Review / Re-enter the Review toggle button: Toggles Your Status between In
Progress and Completed. The Complete button on the ribbon (Home tab, Review group) does the
same thing.
View All Artifacts button: Opens an artifact list with all the artifacts listed. After you click View All
Artifacts, the Your Status field is automatically changed from Not Started to In Progress.

Features and Menu Functions

The Home tab on the ribbon provides you with some useful features to enhance your review experience:

Follow: Allows you to follow or unfollow an artifact.
Follow: Allows you to begin following an artifact.
Unfollow: Allows you to unfollow an artifact that you are currently following.

Refresh: Refreshes the artifact that you are currently viewing.
Approved: Sets the review status of the artifact to Approved. You can only approve artifacts if you have
approver permissions and if you are reviewing a sealed baseline artifact. Approver permissions are set by
the author of the review artifact.
Not Specified: Sets the review status of the artifact to Not Specified, which indicates that you have not yet
approved or disapproved the artifact. This button is only available if you have approver permissions and if
you are reviewing a sealed baseline artifact.
Disapproved: Sets the review status of the artifact to Disapproved. You can only disapprove artifacts if you
have approver permissions and if you are reviewing a sealed baseline artifact. Approver permissions are set
by the author of the review artifact.
New Comment: Opens the Discussions tab in the utility panel, allowing you to add a new comment to the
artifact.
Complete the Review: Toggles your review status between Completed and In Progress.
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Simulate: Allows you to run a simulation while reviewing artifacts that can be simulated. This button is only
accessible when simulation is supported for the selected artifact.
Go To: Allows you to quickly navigate to an artifact by its ID.

Adding comments to an artifact in a review
Adding comments to review artifacts is the most common action that you will perform while participating in a
review. Adding comments allows you to provide feedback and suggestions about the artifacts contained in the
review.

Note: All artifacts in a review are read-only in the Reviewers Experience. Live artifacts may be changed
during the review (but not using the Reviewers Experience) while baseline artifacts cannot be changed.
However, you can use the New Comment button on the ribbon (Home tab, Artifact group) to add a
comment to any artifact in the review package. When you click the New Comment button, the
Discussions tab is automatically opened in the utility panel.

To add comments to an artifact in a review:

1. Open the review.

Choose one of the following options to open the review:

Click the link in the review notification email.
Click the review link located on the right side of your activity center.
Click the Open Review button located in the main content area of the review artifact, if you have
access to open the artifact.

2. View the artifacts included in the review.

1. Click the View All Artifacts button to view the artifacts in the review.
3. Open an artifact.

Click the artifact ID link of the artifact you want to open.

4. Open the Discussions tab in the utility panel.

1. Click the Discussions tab in the utility panel.

5. Add a new comment or reply to an existing comment.

Read more about Adding a new comment and Replying to an existing comment.

Changing the approval status of an artifact
If a review is active, you can change the approval status of artifacts. However, you can only change the approval
status of artifacts if your review status is set to InProgress. If your review status is set to Completed, you must first
change it to InProgress. Read more about Changing your review status.

To change the approval status of an artifact:

1. Open the review.

Choose one of the following options to open the review:
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Click the link in the review notification email.
Click the review link located on the right side of your activity center.
Click the Open Review button located in the main content area of the review artifact, if you have
access to open the artifact.

2. View the artifacts included in the review.

1. Click the View All Artifacts button to view the artifacts in the review.
3. Open an artifact.

Click the artifact ID link of the artifact you want to open.

4. Approve or disapprove the artifact.

1. Click the Approved or Disapproved button on the ribbon (Home tab, Artifact group).

Note: You can also remove the approval status by clicking the Not Specified button
on the ribbon (Home tab, Artifact group).

The Electronically Sign Artifact dialog box appears if electronic signature validation is required.

To provide your electronic signature, verify your identify by providing your login credentials.

Changing your review status
It is best practice to change your review status to completed after you have finished reviewing the artifacts in a
review. This helps other users to determine how many people have completed the review. However, you may
wish to re-enter the review if you have additional comments to add, or if you wish to change the approval status of
artifacts in the review.

As long as the review is still active, you can change your review status.

To change your review status:

1. Open the review.

Choose one of the following options to open the review:

Click the link in the review notification email.
Click the review link located on the right side of your activity center.
Click the Open Review button located in the main content area of the review artifact, if you have
access to open the artifact.

2. Toggle your status between Completed and InProgress.

Choose one of the following methods to toggle your status:

Click the complete button on the ribbon (Home Tab, Review group) to toggle your review
status.
Click the Re-enter the Review/Complete the Review toggle button in the main content area of the
review.
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As you toggle your status, the Your Status field in the main content area switches between Completed
and InProgress.

About electronic signatures

Note: Electronic signatures can only be requested for formal reviews.

Blueprint allows review coordinators to request electronic signatures from approvers. An electronic signature is an
indication that a requested approver verified his or her identity via a means of authentication and provided input
on the review. E-signature is a mode of verification that can help you meet certain industry standards and auditing
requirements.

Electronic signatures and approvers
The electronic signature feature can be enabled within a new formal review.

Note: Project administrators can set all new formal reviews to require electronic signatures by default in
Project Settings (Project Administration Console).

When this option is enabled, electronic signatures are enabled for all approvers in the formal review.

After a review has started, review participants can launch the review in the Reviewers Experience. When the
review participant chooses to approve or disapprove an artifact, Blueprint prompts the user for an electronic
signature. The user must confirm his or her identity using federated authentication or password authentication.
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Note: The federated authentication section of the Electronically Sign Artifact dialog can be customized
within the Instance Administration Console.

The electronic signature and approval status details appear on the Reviews tab (bottom pane) when the artifact is
selected.

The electronic signature and approval status details are organized into the following columns:

Review Participants

Approval

Electronically Signed On

Requesting electronic signatures for a formal review

Note: Project administrators can set all new formal reviews to require electronic signatures by default in
Project Settings (Project Administration Console).

Blueprint allows review creators to request electronic signatures from approvers in a formal review. Electronic
signatures can only be enabled for all approvers in a formal review.

To request electronic signatures from approver(s):

Note: In order to configure a formal review package, you must first create a baseline to include in the
review package.

1. Create a review package.

Click the New button, point to Child Artifact and then click Review.

2. Select a baseline to include in the review.

Click Select Contents and Approval.

The Choose Review Contents dialog box appears.

Select Formal Review.

Select your baseline and then click Add.
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Click OK.

Note: Only after you select your baseline can you enable Require electronic signatures for formal
reviews.

3. Select Require electronic signatures for formal reviews.

The electronic signature feature can only be enabled for all approvers in a formal review.

4. Add the approvers.

Click Select Review Participants.

Select the users you want to include in your review and then click OK.

5. Start the review.

Click the Start Review button.

To make the review live, click the Publish button (Artifacts group, Home tab).

When approvers begin the review and either approve or disapprove an artifact,they must provide electronic
signatures either via federated authentication or password authentication.
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Importing and Exporting
Blueprint allows you to import and export data using a variety of methods.

Blueprint allows you to import:

textual requirements from Microsoft Excel
glossary terms from Microsoft Excel
Visio diagrams

Blueprint allows you to export:

artifacts to an Office Document
artifacts to an ALM target
test plans to Excel or an ALM target

Importing requirements from Microsoft Excel
Blueprint provides you with the ability to import requirements from aMicrosoft Excel spreadsheet. In other words,
you can create your requirements in Microsoft Excel and then import them into Blueprint.

Note: You cannot undo an import from Excel. You can, however, delete the imported requirements.

Blueprint provides the following features to make importing requirements easier:

A preview of the requirements are displayed prior to performing the actual import operation.
A list of any mismatches, between the Excel spreadsheet and the Blueprint project, in terms of Artifact
Types, Properties, or Valid Values. The list identifies the column/row in the spreadsheet so you can fix the
error prior to importing.
Blueprint allows you to select the project, and the folder or parent requirement under which you want to
import the requirements. After the import is complete, you can drag and drop requirements to adjust the
hierarchy.

Tip: To better visualize where the requirements will be imported, we recommend that you turn offWrap
Text (View tab, Artifact List group) option on the ribbon, and select the folder or parent requirement
under which you want the new requirements to be imported.

Sample Import Spreadsheets
For your convenience, take a look at the following examples:

Requirement Import Template: Provides a basic template with only system properties. This template will
work with all Blueprint projects.

Sample Requirement Import: Provides an example with hierarchy columns, custom artifact types, and
custom properties. Here are a few important details to keep in mind while you are looking at this template:

The Hierarchy column (and blank columns to the right of it) are optional: depending on where +
symbol is, the artifacts will be made children

In this template, the values in the Artifact Type column are custom artifact types. This template will
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not work unless the project contains Artifact Types called Business Rule and Business Requirement.

Additional columns (example: Priority, Effort in Days) are custom properties and must exactly match
the name of the custom property in your project.

Excel Spreadsheet Format
Each new requirement that you want to import must appear as a new row in the spreadsheet. The Excel
spreadsheet looks like this:

The following columns can be included in the Excel spreadsheet:

Spreadsheet
Column
Name

Description
Required

or
Optional

Valid Values

Hierarchy You can use Hierarchy columns to specify
the relative outline level at which each
Textual Requirement will be imported.
When no Hierarchy is specified, all
requirements are imported at the same
hierarchy level.

Optional The plus sign, + , must appear in the
appropriate column depending on the
desired hierarchy.

Name Defines the name of the requirement. Required Specify the text that you want to import as
the name of the new requirement.

Artifact
Type

Defines the artifact type. Required This value must be an artifact type that
exists in the project to which you are
importing. In other words, requirements
are only imported when matching artifact
types have been configured by the project
admin in the Blueprint project.

Description Defines the description of the
requirement.

Optional Specify the text that you want to import as
the description of the requirement.
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Spreadsheet
Column
Name

Description
Required

or
Optional

Valid Values

Custom
Artifact
Properties
(example:
Priority,
Owner)

Allows you to import values for custom
properties in your project.

Optional Other Excel columns, such as Priority or
Effort in Days, will only be imported when
matching Properties and Valid Values have
been configured by the Project Admin in
the Blueprint project.

To import requirements fromMicrosoft Excel:

1. Create your import spreadsheet using Microsoft Excel. Save the document as a .xlsx file.

2. Click the Artifacts button on the ribbon (Import/Export tab, Import group).

3. Select the project to which you want to import the requirements. Click Next.

4. Select the folder or parent requirement under which you want to import the requirements. Click Next.

5. Click the button and locate the .xlsx file that contains your requirements.

A list of any mismatches, between the Excel spreadsheet and the Blueprint project, in terms of artifact
types, properties, or valid values. The list identifies the column and row in the spreadsheet so you can fix
the error prior to importing. You must correct all validation errors before you can import the requirements.
You can click the Validate button at any time to re-validate the import data.

When the data is validated without any errors, click Next.

6. Read the import summary to verify that the requirements are going to import as expected. To continue,
click Next.

A status summary is displayed.

7. Click Finish to close the dialog.

After the requirements are imported, they appear as unpublished and unsaved artifacts. You must publish these
artifacts before other users can view them. You can discard the changes if you notice a problem with the import.

Importing glossary terms from Microsoft Excel
Blueprint provides you with the ability to import glossary terms from aMicrosoft Excel spreadsheet. In other
words, you can create your glossary terms in Microsoft Excel and then import them into Blueprint.

Important: You must open a glossary artifact before the Glossary Terms button becomes accessible on
the ribbon (Import/Export tab, Import group).

To get started, simply download the glossary term import template and add your glossary terms and definitions on
a new row.

To import glossary terms:

1. Create your import spreadsheet using Microsoft Excel. Save the document as a .xlsx file.

2. Open a glossary artifact

3. Click the Glossary Terms button on the ribbon (Import/Export tab, Import group).
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4. Click the button and locate the .xlsx file that contains your glossary terms.

A list of any validation errors is displayed. You must correct all validation errors before you can import the
textual requirements. You can click the Validate button at any time to re-validate the import data.

When the data is validated without any errors, click Next.

5. Read the import summary to verify that the glossary terms are going to import as expected. To continue,
click Next.

A status summary is displayed.

6. Click Finish to close the dialog.

After the glossary terms are imported, the glossary artifact contains unsaved and unpublished changes. You must
publish the artifact before other users can view the new glossary terms. You can discard the changes if you notice a
problem with the import.

Generating an office document
Blueprint allows you to generate Microsoft Word and Microsoft Excel documents using the data from your
Blueprint artifacts.

Before you can generate office documents, your project administrator must author a template and add the
template to the project.

Here's an example of a generated document in MS Word format:
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Here's an example of a generated document in MS Excel format:
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You can export artifact data to aMicrosoft Word or Microsoft Excel document, assuming your project administrator
has added templates to the project.

To generate a Microsoft Word or Microsoft Office document:

1. Click the Office Document button on the ribbon (Import/Export tab, Export group).

The Source Project screen of the Generate Office Documents dialog appears.

2. Select the project that contains the artifacts that you want to include in the generated office document, and
then click Next.

The Document Template screen appears.

3. Select the document template to use, and then click Next.

The name and format of each template is displayed. The template format can be MSWord or MS Excel. MS
Word templates can only produce MS Word output. MS Excel templates can only produce MS Excel output.

Note: If there are no templates listed, your project administrator must author a template and add
the template to the project.

After you click Next, The Document Source screen appears.

4. Select whether you want to use data from live artifacts, or data from a baseline or review, and then click
Next.

If you select the Baseline or review option, you must select a baseline or review.

After you click Next, the Document Scope screen appears.
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5. Select the document scope, and then click Next.

Select the artifact(s) that you want to include in the document. Simply select the artifacts and click the Add
button.

Tip: To select all artifacts in a folder, select the folder and then click Select All.

6. Specify your document output options.

Specify the Document Name and location for the generated document.

The document generation process happens in the background. If images need to be generated, a
popup window appears so you can see the progress of the image generation.

Generate Images for any graphic artifact being exported: Defines whether or not you want to
generate images for graphic artifacts that you are exporting, such as diagrams. If this option is
disabled, images are not exported.

If this option is disabled, images (that is, graphic artifacts) are not included in the document output.

When office documents are generated in Blueprint, they are automatically saved in Blueprint for reference
purposes.

7. Click Finish.

The document generation process happens in the background. If images need to be generated, a popup
window appears so you can see the progress of the image generation.

After the document has generated successfully, you can find the new document artifact at the output location that
you specified. Simply open the document artifact and click the Download link to download or view the generated
office document.

Note: If you are using Internet Explorer 8, you must enable the automatic prompting for file downloads
security setting before you can download the file from Blueprint. To enable this setting, click Tools >
Internet Options > Security > Custom level... > Downloads and then enable the Automatic prompting
for file downloads option.

About ALM integration
ALM integration allows you to export artifacts to an ALM (Application Lifecycle Management) system. Your project
administrator must setup an ALM Target and grant you access to the target before you can export artifacts to an
ALM system.

Read the example below to learn more about ALM integration works in Blueprint.

What data is exported to the ALM system?

The following data is exported:

artifact data (example: name, description, and other properties including custom properties)
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Note: The way in which artifact types and artifact properties are mapped depends on how the
ALM target is configured in Blueprint. The artifact types and properties must be mapped in order
to export the data.

sub-artifact data

Note: The concept of sub-artifacts is not preserved in the ALM system after the export. Any data
related to a sub-artifact in Blueprint is rolled up to the artifact level in the ALM system. For
example, if a shape (sub-artifact) in a diagram contains file attachments, the files are exported but
they are associated with the artifact.

artifact attachments (assuming this is option is configured in the ALM target)
artifact traces (assuming both of the traced artifacts are exported to ALM)
diagram image (for UI mockups, business process diagrams, domain diagrams, generic diagrams)
each artifact that is exported to an ALM system contains a hyperlink to the original artifact in Blueprint.

The following data is not exported:

comments
version history
traces (if both artifacts are not in the ALM system)

Example

Exporting artifacts for the first time

Let's start by creating a new Login folder in Blueprint and then creating 3 new artifacts:

Login (textual requirement artifact)
Login Use Case (use case artifact)
Login Page (document artifact with a .jpg file)

After the new artifacts are published, the artifact list looks like this:

Now we will use the ALM Export feature to export these artifacts to the ALM system. The export settings used are:

Publish all artifacts selected
Publish Path: Requirements\Export_Mar17

The Change Summary screen in the ALM Export Wizard looks like this:
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As you can see in the Change Summary image, there are 4 new artifacts being exported to the ALM System (the
Login folder and the 3 new artifacts).

After the export is complete, here is what the new items look like in HP Quality Center:

Exporting artifact changes and deletions

Now, lets make the following modifications in Blueprint:

update the description of the Login textual requirement.
create a new UI mockup called Login Mockup
delete the Login Page document artifact

After the changes are made, the artifact list looks like this:

Now we will use the ALM Export feature to export these artifacts to the ALM system. The export settings used are:

Publish all artifacts that changed since last publish, 3/17/2012 1:28PM
Export Path: Requirements\Export_Mar17

The Change Summary screen in the ALM Export Wizard looks like this:

As you can see in the Change Summary image, the export to the ALM System includes 1 added artifact, 1 updated
artifact, and 1 deleted artifact.

After the export is complete, the new items appear in HP Quality Center v11:
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As you can see in the image above, the Login Page item is deleted, the Login Mockup has been added, and the
description of the Login requirement has been updated.

About ALM integration
ALM integration allows you to export artifacts to an ALM (Application Lifecycle Management) system. Your project
administrator must setup an ALM Target and grant you access to the target before you can export artifacts to an
ALM system.

Read the example below to learn more about ALM integration works in Blueprint.

What data is exported to the ALM system?

The following data is exported:

artifact data (example: name, description, and other properties including custom properties)

Note: The way in which artifact types and artifact properties are mapped depends on how the
ALM target is configured in Blueprint. The artifact types and properties must be mapped in order
to export the data.

sub-artifact data

Note: The concept of sub-artifacts is not preserved in the ALM system after the export. Any data
related to a sub-artifact in Blueprint is rolled up to the artifact level in the ALM system. For
example, if a shape (sub-artifact) in a diagram contains file attachments, the files are exported but
they are associated with the artifact.

artifact attachments (assuming this is option is configured in the ALM target)
artifact traces (assuming both of the traced artifacts are exported to ALM)
diagram image (for UI mockups, business process diagrams, domain diagrams, generic diagrams)
each artifact that is exported to an ALM system contains a hyperlink to the original artifact in Blueprint.

The following data is not exported:

comments
version history
traces (if both artifacts are not in the ALM system)

Example

EXPORTING ARTIFACTS FOR THE FIRST TIME

Let's start by creating a new Login folder in Blueprint and then creating 3 new artifacts:

Login (textual requirement artifact)
Login Use Case (use case artifact)
Login Page (document artifact with a .jpg file)

After the new artifacts are published, the artifact list looks like this:
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Now we will use the ALM Export feature to export these artifacts to the ALM system. The export settings used are:

Publish all artifacts selected
Publish Path: Requirements\Export_Mar17

The Change Summary screen in the ALM Export Wizard looks like this:

As you can see in the Change Summary image, there are 4 new artifacts being exported to the ALM System (the
Login folder and the 3 new artifacts).

After the export is complete, here is what the new items look like in HP Quality Center:

EXPORTING ARTIFACT CHANGES AND DELETIONS

Now, lets make the following modifications in Blueprint:

update the description of the Login textual requirement.
create a new UI mockup called Login Mockup
delete the Login Page document artifact

After the changes are made, the artifact list looks like this:

Now we will use the ALM Export feature to export these artifacts to the ALM system. The export settings used are:

Publish all artifacts that changed since last publish, 3/17/2012 1:28PM
Export Path: Requirements\Export_Mar17

The Change Summary screen in the ALM Export Wizard looks like this:
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As you can see in the Change Summary image, the export to the ALM System includes 1 added artifact, 1 updated
artifact, and 1 deleted artifact.

After the export is complete, the new items appear in HP Quality Center v11:

As you can see in the image above, the Login Page item is deleted, the Login Mockup has been added, and the
description of the Login requirement has been updated.

About test generation
Test generation allows you to generate test plans from your use cases. You can also export the tests to an ALM
target.

Blueprint generates a test for each path variation that can be taken in a use case. For example, if you have a simple
use case with one alternate flow, there are 2 possible paths that can be taken. Therefore, Blueprint generates 2
tests for this use case. One of the tests would cover the main flow of the use case, and the second test would take
the alternate flow.

Follow the example below to learn more about how test generation works in Blueprint.

Example

Here's the simple use case that we will use to generate a test plan:
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A test plan was generated with the following options:

Selected use case only: there are no included use cases in the example, so this option is satisfactory.

Generate only for 10 levels: the test plan will generate tests for level 10 and below (that is, all use
case levels).

Break loop-backs: Yes

Here's the an example of the generated test plan in .csv format:

Because the example only contains one alternate flow, there are 2 path variations in this use case. Therefore, there
are a total of 2 tests generated for this use case. There are a number of columns that provide you with data:

INPUT: provides the actor steps
EXPECTED RESULT: provides the system steps
REFERENCES: provides information about any included use cases, external flows, attached UI Mockups, and
so on.

Here's an example of the one of the tests after exporting to HP Quality Center:
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Generating a test plan

When you generate a test plan, you can view the generated tests in .csv format. You can also export the tests to
an ALM system if your project administrator has configured an ALM target and granted you access to it.

To generate a test plan from one or more use cases:

1. Click the Test Plans button on the ribbon (Import/Export tab, Export group).

The Select Project screen of the Test Plan Generation dialog is displayed.

2. Select the project that contains the use cases that you want to generate tests for, and then click Next.

The Select Revision screen appears.

3. Select whether you want to generate tests from data in live artifacts, or data from a baseline or review, and
then click Next.

The Select Use Cases screen appears.

4. Place a checkmark beside all use cases that you want to generate tests for, and configure the use case
options if required.

The following options are available:

Selected use case only (default): If this option is chosen, only the selected use cases are included in
the test plan.
Selected use case and children: If this option is chosen, the test plan also generates tests for all
included use cases and external flow use cases.

Generate only for 10 (default) levels: Defines the number of levels to include in the tests.
Break loop-backs: If selected, loop-backs are broken in order to reduce the number of tests in the
test plan. The resulting test plan still provides full test coverage but does not cover all permutations
of conditions.

5. Click Next to generate the tests.

Please wait while the test plan is generated. The Review Test Plans screen is displayed after the test
generation is complete.

6. Click Download tests to CSV to save the tests as a .csv file.

Note: If you are using Internet Explorer 8, you must enable the automatic prompting for file
downloads security setting before you can download the file from Blueprint. To enable this setting,
click Tools > Internet Options > Security > Custom level... > Downloads and then enable the
Automatic prompting for file downloads option.

You can open this file in Microsoft Excel to review the test plan.

7. Click Next or Finish.
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The Next button is only available if your project contains ALM targets. If your project contains ALM Targets,
you can click Next to export the tests to your ALM Target..

8. On the Select Target screen, select the target that you want to export the tests to, and then click Finish. Or,
click the Cancel button to close the dialog without exporting the tests to an ALM target.

About Visio integration
Blueprint supports the ability to import and export Microsoft Visio diagrams.

About importing Visio diagrams

You can import Visio diagrams into the following artifact types:

Generic diagram
UI mockup
Business process diagram

When you import a Visio diagram, Blueprint substitutes your Visio shapes with matches that exist on the palette. In
cases where a suitable Blueprint shape does not exist, the original Visio shape is imported as an external shape.

Note: Blueprint does not currently support importing rich text formatting in shapes from Visio. Instead,
rich text is imported as plain text formatting.

About External Shapes

An external shape is a Microsoft Visio shape that has been imported as a vector or bitmap image and has not been
replaced by an equivalent shape on the Blueprint palette.

The differences between vector images and bitmap images are as follows:

Vector Bitmap

Has a transparent background Has an opaque background

Quality is not diminished when the image is resized Quality is diminished when the
image is resized

Can be edited with the following tools:
Drawing tools (Editor Tools tab, Drawing group)
Font tools (Editor Tools tab, Font group)
Paragraph tools (Editor Tools tab, Paragraph group)

Image cannot be edited using the
following Blueprint tools:

Drawing tools (Editor Tools
tab, Drawing group)
Font tools (Editor Tools tab,
Font group)
Paragraph tools (Editor Tools
tab, Paragraph group)

Is suited for print
For more information about exporting a diagram for print,
see Exporting a diagram to Visio.

Print quality is diminished
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About exporting Visio diagrams

You can export any of the following diagrams in Visio 2010:

Generic diagrams
UI mockups
Business process diagrams
Use case diagrams
Storyboard diagrams

Blueprint exports diagrams in Visio drawing format, .vsd.

Importing a Visio diagram

Important: This feature is only available if Blueprint is configured to run with elevated in-trust browser.

You can import Visio diagrams into the following artifact types:

Generic diagram
UI mockup
Business process diagram

When you import a Visio diagram, Blueprint substitutes your Visio shapes with matches that exist on the palette. In
cases where a suitable Blueprint shape does not exist, the original Visio shape is imported as an external shape.

Note: Blueprint does not currently support importing rich text formatting in shapes from Visio. Instead,
rich text is imported as plain text formatting.

Requirements

To import a Visio diagram, you require the following:

Elevated trust in-browser
Blueprint version 5.1.2 and later
Microsoft Visio 2010 must be installed. However, you can import visio files from version 2003 and 2007.

To import a Visio diagram:

1. Make sure that the first page of the document contains the diagram you want to import and then save the
document on your computer as a .vsd file.

Note: Only .vsd files can be imported.

2. In Blueprint, open the artifact to which you want to import the Visio diagram.

3. Click the Visio Diagram button on the ribbon (Import/Export tab, Import group).
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The open dialog box appears.

4. Select the Visio diagram you want to import and then click Open.

The diagram appears in the main content area.

Upon importing a diagram, Blueprint replaces the diagram's shapes with equivalent Blueprint shapes. In certain
cases, imported shapes have no equivalents on the Blueprint palette.

Tip: By using the External Shapes indicator, you can identify imported shapes that have not been replaced
with Blueprint shapes.

To identify an external shape:

Select the External Shapes check box on the ribbon (View tab, Show Indicators group):

Indicators appear next to all external shapes in your diagram.

Exporting a diagram to Visio

Important: This feature is only available if Blueprint is configured to run with elevated in-trust browser.

You can export any of the following diagrams for use in Microsoft Visio 2010:

Generic diagrams
UI mockups
Business process diagrams
Use case diagrams
Storyboard diagrams

Blueprint exports diagrams in Visio drawing format, .vsd.

Requirements

To export a diagram to Visio, you require the following:

Elevated trust in-browser
Microsoft Visio 2010
Blueprint version 5.1.2 and later

To export your Blueprint diagram to a Visio .vsd file:
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1. In Blueprint, click the Visio Diagram button on the ribbon (Import/Export tab, Export group).

The save dialog box appears.

Important: If you want to import your Blueprint diagram into an existing Visio document, make
sure the Visio document is closed.

2. Enter a filename for your export diagram and then click Save.

You have successfully exported your Blueprint diagram to a Visio .vsd file.

About saving artifacts as images
Blueprint allows you to save visual artifacts, such as diagrams, as an image file on your computer so you can use it
for other purposes. For example, you may want to print the image or e-mail it to others.

Tip: If you want to share the artifact with others, you may want to consider sharing the artifact
with Blueprint instead of distributing an image. If you share the artifact using Blueprint, the viewers can
see all associated information about the artifact such as properties and comments.

When you save an artifact as an image, Blueprint always creates an image using the settings that are currently in
use. The zoom level is the only exception to this rule. For example, if you have grid lines enabled in Blueprint when
you save the image, the grid lines are included in the image. The image is always saved with a 100% zoom level,
regardless of the current setting in the artifact editor.

Applicability

You can save the following artifacts as an image:

Use case (workflow view only)
Use case diagram
Business process diagram
Generic diagram
Domain diagram
UI mockup
Storyboard

When the Save to Image feature is applicable, a Save to Image button appears on artifact editor contextual tab

on the ribbon. For example, if you open a generic diagram, the Save to Image button appears on the ribbon (
Generic Diagram tab, Image group). If you open an actor or document artifact, this button is not available.

Supported image formats

You can save diagrams to the following image formats:
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PNG
JPG

Saving an artifact as an image

To save an artifact as an image:

1. Open the artifact that you want to save as an image.

The Save to Image feature is only available for visual artifacts (such as diagrams). Refer to the Applicability
section to learn more about support for this feature.

2. Click the Save to Image button on the ribbon.

The Save to Image button is located on artifact editor contextual tab (example: Generic Diagram tab) in the
Image group.

3. Specify the location, file name, and file type.

4. Click Save.

You can now access the image on your computer at the location you specified.

Exporting an artifact list view to Excel
Blueprint allows you to conveniently export your artifact list view to aMicrosoft Excel document (.xls format).

Collapsed and expanded artifacts

When you export your artifact list view, the generated Excel document lays out your artifacts as they appear in
Blueprint.

If you expand any parent artifacts before exporting your list view, their children appear in the generated Excel
document.

If you collapse any parent artifacts before exporting your list view, their child artifacts do not appear in the
generated Excel document.
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Preserved column details

When you export your artifact list view to Microsoft Excel, the following aspects of your artifact list are preserved:

Name
ID
Description
Artifact Type
Any custom properties you have in your view

Indicators (that is, icons for trace relationships, comments, attachments and follows that link to related data in
Blueprint) are not preserved.

To export your artifact list view to Microsoft Excel:

1. Expand and collapse items in your artifact list so it is displaying the content that you want included in your
generated Excel document.

2. Click the Artifact List View button on the ribbon (Import/Export tab, Export group).

The Save As dialog box appears.

3. Name the file with an .xls extension in your preferred location and then click Save.
After the document has generated successfully, you can find the new Excel document at the output location that
you specified.

Tip: To open the .xls file, launch Microsoft Excel and then click File > Open. Alternatively, you can right
click the .xls file and click Open with > Microsoft Excel. If you attempt to open the .xls file from your
browser, you may experience issues.

About artifact printing

Overview
Blueprint allows you to efficiently print individual artifacts in Microsoft Word and PDF files. You can print the latest
version of an artifact or choose a specific version to print.
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Output file

If you are using the default print template, your output file contains the following information about the artifact:

Artifact ID
Artifact name
Artifact type
Artifact URL
Version number
Description
Created By
Created On
Last Edited By
Last Edited On
Any custom properties
Any trace relationships

Your artifact data is laid out in a table (see images below).
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Blueprint supplies a default template that structures your artifact for printing. The default print template is
accessible at the project level as well as at the instance level.
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For more information about the print template accessibility at the project level and the instance level, see
Modifying the default print template at the project level and Modifying the default print template at the instance
level.

Modifying the default print template at the project level
Blueprint provides project administrators with a default Word template for the purpose of exporting and printing
artifacts.

The template is written and designed using the document template authoring add-in.

We do not recommend making changes to the template directly unless you have document template authoring
experience. For more information about document template authoring, see the Document Template Authoring
Help.

Note: The default print template can be changed at two different levels of administration privileges.
Instance administrators with the applicable privileges can modify the default print template within the
Instance Administration Console, setting a new default template for all projects. Both instance
administrators and project administrators with the applicable privileges can change the default print
template within the Project Administration Console, which sets a new print template for that individual
project only.

Once you change the print template at the project level, changes to the template at the instance level do not
override the project level template.

To modify the default print template:

https://documentation.blueprintcloud.com/DeveloperCenter/TemplateAuthoring/
https://documentation.blueprintcloud.com/DeveloperCenter/TemplateAuthoring/
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1. Open the Project Administration Console.

2. Click the Project Print Template link.

Important: To restore the system default document template later on, it is a good idea to click the
Download link to save a copy of the default document template locally. When you want to restore
the system default document template, you can simply click the Replace link to upload it. If you do
not save a copy of the system default document template and you use the Restore operation, you
will restore the latest document template that has been uploaded by the instance administrator.

3. Create a new template or modify an existing document template.

If you want to modify the existing template, click the Download link.

Note: If you are using Internet Explorer 8, you must enable the automatic prompting for file
downloads security setting before you can download the file from Blueprint. To enable this setting,
click Tools > Internet Options > Security > Custom level... > Downloads and then enable the
Automatic prompting for file downloads option.

4. Click the Replace link.

The save dialog box appears.

5. Select your new print template and then click Open.
6. Click Save.

Your new print template is saved. Whenever you click the Print to PDF button or the Print to Word button on the
ribbon (Home tab), your print template is used to export an artifact to a file for printing purposes.

Printing a historical version of your artifact

Note: Before printing, make sure to save and publish your artifact.

To print a specific version of your artifact:

1. Click the artifact version you want to print (History tab).

The artifact details appear in the main content area.

2. Select Print to PDF and then click Print to Word (Home tab, Artifacts group).

Your artifact appears in aWord file.

In Word, you can perform any stylistic edits and print the artifact with your preferred settings.

3. Print your Word artifact.

On the Filemenu, click Print.

When the print dialog box appears, click OK.

Printing an artifact to a PDF document

Note: Before printing, make sure to save and publish your artifact.
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To print your artifact to a PDF document:

1. Click the artifact you want to print.

The artifact details appear in the main content area.

2. Select Print to PDF and then click Print to PDF (Home tab, Artifacts group).

Your artifact appears in a PDF file.

3. Print your PDF artifact.

On the Filemenu, click Print.

When the print dialog box appears, click OK

Printing an artifact to a Word document

Note: Before printing, make sure to save and publish your artifact.

To print your artifact to a Word document:

1. Click the artifact version you want to print (History tab).

The artifact details appear in the main content area.

2. Select Print to PDF and then click Print to Word (Home tab, Artifacts group).

Your artifact appears in a Word file.

In Word, you can perform any stylistic edits and print the artifact with your preferred settings.

3. Print your Word artifact.

On the Filemenu, click Print.

When the print dialog box appears, click OK.
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View management and saved views
A view refers to the artifact list settings that control what and how information is displayed in the artifact list.

Blueprint remembers which view you selected for individual folders. You can see which view you are using by
looking at the ribbon (View tab, Artifact List group):

The System view automatically saves your artifact list view settings. At any time, you can select the System view to
restore your last used settings. The System view, therefore, can be different for each user because it saves the last
used settings. This view cannot be reset. The System view is sufficient for many users, while others may want to
take advantage of Saved Views.

Artifact list view settings and scope
Views consist of the following artifact list settings:

Show/Hide Columns

You can configure which columns of data are displayed in the artifact list by clicking Column Options (View
tab, Artifact List group).

Column Order

You can configure the order of columns in the artifact list by clicking Column Options (View tab, Artifact List
group) or by dragging and dropping columns in the artifact list.

Column Sort Order

To adjust the column sort order, click a column header in the artifact list.

Column Filters

To adjust the filter settings, click the filter button in the artifact list column headers.

After applying a column filter, the filter icon changes to yellow . The yellow filter icon is a visual reminder
that the filter is applied.

Column Width

To adjust the column width, drag and drop the edge of a column in the artifact list.

Saved Views
Saved views allow you to save your artifact list view settings so you can easily restore those settings at any time. For
example, you may want one view that only displays basic artifact information, and another view that displays
detailed information such as custom properties.

Note: Blueprint allows you to create and customize views on a project basis. When you create a view, it
only appears in the project where you originally created the view.

You can make your views private, or you can share your views so other users can take advantage of your view
settings. When you create a shared view, you can control whether or not other users have the ability to modify or
delete the shared view.
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When you modify artifact list settings to values that differ from the view that is currently activated, an asterisk (*) is
displayed beside the view name. You can click the Reset button at any time to revert back to the saved view
settings. If you are using a Private or Shared (Allow Modifications) view, you can click the Save View button to
modify the view that is currently selected by overwriting the existing view settings. Alternatively, you can use the
Save View As button to create a new view using the current artifact list settings.

Tip: Be careful when you are using shared views because shared views can be changed by all users
and/or the creator of the view, depending on the type of shared views. If you depend on a shared view to
perform tasks, you may want to consider duplicating the view and saving it as a private view so that it
cannot be modified without your knowledge.

Saved View Types

There are three types of views:

Private

When you create a private view, you are the only user who can use and modify the view.

Shared (Read-Only)

When you create a Read-Only Shared view, all users can use the view. However, you are the only person
who can modify the view.

Shared (Allow Modifications)

When you create a Shared (Allow Modifications) view, all users can view and modify the view.

Selecting a view
When you select a view, your artifact list settings are automatically changed with the settings that are stored in the
selected view. Read more about the scope of views to learn about the settings you can save and restore using
views.

Saved views allow you to save your artifact list view settings so you can easily restore those settings at any time. For
example, you may want one view that only displays basic artifact information, and another view that displays
detailed information such as custom properties.

Tip: Be careful when you are using shared views because shared views can be changed by all users
and/or the creator of the view, depending on the type of shared views. If you depend on a shared view to
perform tasks, you may want to consider duplicating the view and saving it as a private view so that it
cannot be modified without your knowledge.

When you modify artifact list settings to values that differ from the view that is currently activated, an asterisk (*) is
displayed beside the view name. You can click the Reset button at any time to revert back to the saved view
settings. If you are using a Private or Shared (Allow Modifications) view, you can click the Save View button to
modify the view that is currently selected by overwriting the existing view settings. Alternatively, you can use the
Save View As button to create a new view using the current artifact list settings.

To select a different view:

1. Click the Current View option on the ribbon (View tab, Artifact List group) and select the view you want to
select.
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After you select a view, your artifact list is immediately updated with the view settings.

Adding a new view
Saved views allow you to save your artifact list view settings so you can easily restore those settings at any time. For
example, you may want one view that only displays basic artifact information, and another view that displays
detailed information such as custom properties.

You can add as many views as you need. You can also share views so that other users can take advantage of the
view you created.

To add a new view:

1. Set your artifact list options the way you want them. Read more about the artifact list settings that are saved
and restored using views.

2. Click the Save View As button on the ribbon (View tab, Artifact List).

The save dialog appears:

3. Specify a name for the new view.

4. Specify a View Type.

The following view types are available:

Private

When you create a private view, you are the only user who can use and modify the view.

Shared (Read-Only)

When you create a Read-Only Shared view, all users can use the view. However, you are the only
person who can modify the view.

Shared (Allow Modifications)

When you create a Shared (Allow Modifications) view, all users can view and modify the view.

5. Click OK.
The view is automatically selected after you add the view. You can easily select a different view at any time.

Duplicating a view
Duplicating a view allows you to create a new view using the artifact list settings that were saved in an existing
view.
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To duplicate a view:

1. Click the Manage Views button (Views tab, Artifact List group).

2. Click the view that you want to duplicate.

3. Click the duplicate button.

The duplicate view appears in the list with (2) appended to the end of the name.

4. Double-click the name of the duplicated view to modify the name. You can also double-click the view type if
you want to change the type.

5. Click OK.

You can click Cancel instead of OK if you want to discard your changes.

Modifying a view
After you have created a view, you can modify the view settings, the name of the view, and the type of view.

You can modify the following views:

any of your own private views

any Shared (Read-Only) views that you created

any Shared (Allow Modifications) views that you or other users created

To modify the view settings:

1. Click the Current View option on the ribbon (View tab, Artifact List group) and select the view you want to
modify.

2. Change the artifact list settings.

A asterisk (*) appears beside the view name to indicate that there are changes. You can click the Reset
View button at any time to discard changes to a view.

3. Click the Save View button on the ribbon (View tab, Artifact List group).

To modify the name or type of a view:

1. Click the Manage Views button (View tab, Artifact List group).

2. Double-click the view name or view type that you want to change and then make your modifications.

3. Click OK.

You can click Cancel instead of OK if you want to discard your changes.

Deleting a view
You may want to delete views if you no longer need the view or if you find a duplicate, for example.

Note: You cannot delete the System view.

You can delete the following views:
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any of your own private views

any Shared (Read-Only) views that you created

any Shared (Allow Modifications) views that you or other users created

Warning: When you delete a Shared view, other users can no longer access the view. If you delete a
view that another user is using, the System view is automatically selected for that user. You cannot delete
the System view at any time.

To delete a view:

1. Click the Manage Views button (Views tab, Artifact List group).

2. Click the view that you want to delete.

3. Click the delete button.

4. Click OK. You can click Cancel instead of OK if you want to discard your changes.

After you delete a view, the view no longer appears as an option in the Current View selection menu.

Editing the artifact list hierarchy
Blueprint lets you move artifacts into different positions in the artifact list hierarchy. You can use the Indent and
Outdent actions to nest artifacts deeper within the hierarchy or to place them higher in the hierarchy.

The Indent and Outdent buttons are accessible on the Home tab (Artifacts group):

The Indent and Outdent actions are used specifically for parent-child relationship management. You can only
indent an artifact to become a child of other another artifact. Likewise, you can only outdent an artifact if it is a
child of another artifact.

Example

In her BP Air--Rewards ProgramMarketplace project, Tanya, a product manager, has created a
folder artifact called Overview to contain high-level information about her project. At the highest level
in the artifact list, there is an artifact calledMotivation that she wants tomove into the Overview
folder. Tanya uses the Indent operation tomake theMotivation artifact a child of the Overview
folder.

To edit the artifact list hierarchy:
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1. Select the artifact you want to move.

2. Click the Indent button to nest the artifact deeper within the hierarchy or the Outdent button to put the
artifact higher in the hierarchy.

3. Click Publish to make your change live.

Your artifact list has been successfully edited.
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About Version Compare

Overview
Version Compare provides you with the ability to look at the changes that have been applied to an artifact over a
selected period of time. Version Compare works with all types of artifacts in Blueprint.

Example

Susan, a business analyst, wants to see what has changed betweenmajor milestones in her project
so she compares two different baselines.

Example

Latoya, a business analyst, has received approval on a formal review that she sent out a couple of
weeks ago. Since then, some additional feedback has come in and some additional changes have
beenmade to the artifacts. Latoya wants to see all of the changes that need to get re-approved so
she compares the review to a live timestamp.

Example

Maria, a business analyst, created an artifact and then shared the artifact with stakeholders. Over
time, multiple stakeholders mademany changes to the artifact. Maria wants to see what changes
weremade, when and by whom, so she compares the artifact to a past timestamp.

At a high level, Version Compare is a three step process:

1. Select a project node, a folder or artifact(s).

2. Click the Version Compare button.

3. In the Version Compare dialog, select a baseline, review or timestamp.

When the Version Compare report is generated, the report displays changes between the items you
selected in Step 1 and the items or timestamp that you selected in Step 3.

You can compare the following:

Baseline

After you select a baseline and open the Version Compare dialog, you can compare the baseline to the
following:

The contents of another baseline.

The contents of a review.

Timestamp (that is, the baseline at a particular point in time).

Review

After you select a review and open the Version Compare dialog, you can compare the review to the
following:
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The contents of a baseline.

The contents of another review.

Timestamp (that is, the review at a particular point in time)

Project node

After you select a project node and open the Version Compare dialog, you can compare the project node to
the following:

The contents of a baseline.

The contents of a review.

Timestamp (that is, the project node at a particular point in time).

Artifact(s)

After you select one or more artifacts and open the Version Compare dialog, you can compare the artifact
(s) to the following:

The contents of a baseline.

The contents of a review.

Timestamp (that is, the artifact(s) at a particular point in time).

Folder(s)

After you select one or more folders and open the Version Compare dialog, you can compare the folder(s)
to the following:

The contents of a baseline.

The contents of a review.

Timestamp (that is, the folder(s) at a particular point in time).

Version Compare report
A Version Compare report provides you with the ability to view changes that have occurred within an artifact, a set
of artifacts, a baseline or a review over a selected period of time. Version Compare provides a list of actions that
have occurred over the selected period of time. The Version Compare report always compares changes from the
older date to the newer date.

Tip: You can sort and filter your Version Compare results the same way you would sort or filter any
artifact list in Blueprint. You can also export your Version Compare report to Excel.



©2015 Blueprint Software Systems Inc. All rights reserved 169 of 183

Here's an explanation of the data contained in each Version Compare report, outlined in the order the columns
appear:

Data Field Description

Action The type of action that the user applied to the artifact.

Name The name of the artifact that was affected.

ID The ID of the artifact that was affected. The ID contains a hyperlink to the artifact.

Artifact Type The type of artifact that the action was applied to.

Change Type The part of the artifact that changed. For example: a relationship, sub-artifact or actor
inheritance might have changed within the artifact.

Change Summary Identifies the name of the item that changed. For example: the Description of the artifact
might have changed.

Last Edited By The user that last performed the action.

Last Edited Date The time and date the last action occurred.

Different ways of accessing Version Compare
You can access Version Compare in any of the following ways:

Right-click an artifact and then click Version Compare
Select an artifact and then click the Version Compare button on the ribbon (Home tab, Artifacts group)
Right-click a folder or project node in the Explorer panel and then click Version Compare
Open the contents in a baseline and then click the Version Compare button on the ribbon (Home tab,
Artifacts group)

Comparing versions of an artifact
You can view the changes that have occurred within an artifact, multiple artifacts, a review or a baseline by using
Version Compare.
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To compare versions of an artifact:

Note: Before using Version Compare, make sure to save and/or publish the artifacts you want to
compare.

1. Select a project node, a folder, a baseline, a review or artifact(s) that you want to compare.

Note: Regardless of whether you selected the newest or oldest version(s) of your artifact(s),
review or baseline, Blueprint always compares the oldest contents in the Version Compare
analysis to the newest contents.

2. Click the Version Compare button on the ribbon (Home tab, Artifacts group).

The Version Compare dialog box appears.

If you want to include all children in your Version Compare report, select the Compare all children of the
selected artifact(s) to the baseline, review package or timestamp selected above check box.

3. Select a baseline, review package or a timestamp to compare your contents with.

4. Click OK.
Your Version Compare report opens in a new tab. Each action applied to your artifact appears on a new line and
the artifact data is organized according to columns. To learn more about Version Compare reports, see Version
Compare report.

Exporting a Version Compare report to Excel
Blueprint allows you to export your Version Compare report to Microsoft Excel. Once exported, you can use
Microsoft Excel to print your report.

To export your Version Compare report to an Excel document:

1. Click the Artifact List View button on the ribbon (Import/Export tab, Export group).

The Save As dialog box appears.

2. Name the file with an .xls extension in your preferred location and then click Save.

Your artifact appears in an Excel file.

In Excel, you can perform any stylistic edits and print the artifact with your preferred settings.

3. Print your Version Compare report.

On the File menu, click Print.

Click the Print button.

When the print dialog box appears, click OK.
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Artifact versioning and history
Artifact history refers to the ability to view historical versions of an artifact. Every time you publish an artifact, a
new version is saved and can be viewed at any time by opening the History tab in the utility panel.

The history tab allows you to view previous versions of the artifact and compare changes between them.

The history tab in the utility panel looks like this:

A label is displayed at the top of every tab in the utility panel. It provides the ID and name of the artifact or sub-
artifact you are viewing. For example:

Understanding the utility panel history tab
The history tab displays a history table with the following columns:

Version: Indicates the version number.

Note: Version 1 is always the first version of the artifact. The highest version number is always the
most recent. However, keep in mind that you, or another user, may have made changes to the
most recent version and not yet published the changes. In this case, a new version appears in the
history table after the changes are published.

Author: Indicates the name of the person who published the version.
Date: Indicates the date and time the version was published.

Sorting and filtering historical versions

Sorting versions

You can sort the historical versions by version number, author or date. Simply click the column headers to toggle
between an ascending or descending sort order.
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Filtering versions

You can filter versions by version, author and date. Sorting can be useful in many cases but sometimes there may
be an extremely large number of versions. In this case, it may be more effective to filter versions rather than sort
them.

To apply a filter:

1. Click the filter button located beside the column header text, depending on the type of filter you want to
apply.

2. Specify your filter criteria. Refer to the sections below for more information about filtering by version
number, author and date.

3. Click the Filter button.
After applying a column filter, the filter icon changes to yellow . The yellow filter icon is a visual reminder that the
filter is applied.

To remove a filter:

1. Click the Clear Filter button located on each of the filter dialogs.

Filtering by Version Number

Filtering by version allows you to filter the versions based on the version number. The version filter dialog looks like
this:

You can filter by version using one of three methods:

Place a checkmark beside the versions you want to display.
Build a query using the operator drop-downs and by specifying appropriate values. For example, you can
Show rows with value that is less than or equal to 100 And is greater than or equal to 90. This query will
return versions 90 to 100 inclusive.
A combination of the previous two methods. If you select versions using the check boxes AND by specifying
query values, versions are only displayed in the results if all criteria is met.

Filtering by Author

Filtering by author allows you to filter the versions based on the name of the person who published the version.
The author filter dialog looks like this:
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You can filter by version using one of three methods:

Place a checkmark beside the publisher of the versions you want to display.
Type the name (or part of the name) of the publisher of the versions you want to display. For example, type
Fred to display all versions published by individuals with the name Fred or Freddy.
A combination of the previous two methods. If you select versions using the check boxes AND by specifying
query values, versions are only displayed in the results if all criteria is met.

Filtering by Date

Filtering by date allows you to filter the versions based on the date the version was published. The date filter dialog
looks like this:

You can filter by version using one of three methods:

Place a checkmark beside the publication date of the versions you want to display.
Build a query using the operator drop-downs and by specifying dates. For example, you can Show rows with
value that is greater than 10/16/2011 And is less than 10/19/2011. This query will return versions that
were published on 10/17/2011 and 10/18/2011.
A combination of the previous two methods. If you select versions using the check boxes AND by specifying
query values, versions are only displayed in the results if all criteria is met.

Viewing a historical version of an artifact

Note: Historical versions of artifacts are read-only and cannot be modified.

To view the historical version of an artifact:

1. Open an artifact.

Click the artifact ID link of the artifact you want to open.

2. Open the history tab in the utility panel.
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1. Click the history tab icon.

You can also point to the tab icon to view the name of the tab.

3. Click the version ID link of the version you want to view.
The selected version is displayed in a new tab in the main content area.

Viewing the changes between two historical versions
You can view the changes between any two versions of an artifact. Viewing the changes between two versions can
be beneficial if you have reviewed a version of the artifact, and then you want to determine what is different in the
next version.

To view the changes between two historical versions:

1. Open an artifact.

Click the artifact ID link of the artifact you want to open.

2. Open the history tab in the utility panel.

1. Click the history tab icon.

You can also point to the tab icon to view the name of the tab.

3. Select the versions to compare.

You can select a version by clicking a row in the table. Any selected rows are highlighted in blue. To select
multiple rows, simply hold the Ctrl key and click a second row.

If you select only one version, the version will automatically be compared to the previous version.
If you select two versions, the two selected versions are compared.

The changes are automatically displayed at the bottom of the history tab in the utility panel.

Understanding the changes

Changes between versions are displayed at the bottom of the history tab in the utility panel as soon as a version is
selected. The summary of changes looks like this:
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The change history panel is labeled with the artifact name, and outlines the two versions that are compared
(example: New Generic Diagram 1, V2 and V3).

When changes to properties have occurred, you can click the arrow that appears next to Properties and view the
additional details about the changes.

Note: Blueprint displays No History Available if you have only selected Version 1, because there
is no previous version for comparison. The No History Availablemessage is also displayed if you
select more than two versions, because you cannot compare more than two versions.

To view a specific version of an artifact, click the version number in the Version column. The selected version of
the artifact appears in the main content area.

Viewing the changes between two versions of an artifact using Side
by Side
You can view the changes that have occurred within any artifact by using Side by Side View.

Here's an example of two different versions of a UI mockup being compared in Side by Side View:



©2015 Blueprint Software Systems Inc. All rights reserved 176 of 183

To view the changes between two versions of an artifact:

1. Select the artifact you want to view.

2. Select the two versions you want to compare (History tab, Utility Panel).

To select two different versions of an artifact, press CTRL and then select the artifacts.

3. Click the Open Side by Side View link (History tab, Utility Panel).

The two versions appear in a new tab.

To open the latest version of the artifact, click the Open Latest Version link.



©2015 Blueprint Software Systems Inc. All rights reserved 177 of 183

Artifact outline
The outline view of an artifact shows the parent-child relationships of a diagram. The outline view presents the
artifacts and sub-artifacts in a tree-view style, making it quick and easy to navigate diagrams. You can click any sub-
artifact in the outline view, and the sub-artifact is automatically selected in the artifact editor.

Example

Deb, a business analyst, wants to make somemodifications to a large and complex business
process diagram. She has tried using the zoom feature to view the entire diagram in themain content
area, but now the text is too small to read. She has also tried scrolling up and down the diagram, but
she keeps losing her place.

Deb finds the artifact outline in the utility panel and ends up saving herself some time. She can easily
navigate the diagram using the tree view of the sub-artifacts. Deb still uses the graphical view of the
diagram, but she usually uses the artifact outline to locate a specific area.

The artifact outline is available on the outline tab in the utility panel. The outline tab looks like this:

A label is displayed at the top of every tab in the utility panel. It provides the ID and name of the artifact or sub-
artifact you are viewing. For example:

Applicability

Note: The outline view is not available for all artifact types.

The outline view is available for the following artifacts:

Use Cases
Business Process Diagrams
UI Mockups
Storyboards
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Generic Diagrams
Domain Diagrams

You must open an artifact before you can use the outline view. In other words, the outline view is not available if
you simply select an artifact in the artifact list. If the outline view is not applicable for any reason, the following
message is displayed on the outline tab: There are no items to show. This function is not
applicable for the selected item.

Displaying the outline view of an artifact
The outline view of an artifact shows the parent-child relationships of a diagram. The outline view presents the
artifacts and sub-artifacts in a tree-view style, making it quick and easy to navigate diagrams.

To display the outline view of an artifact:

1. Open an artifact that supports the outline view.

Click the artifact ID link of the artifact you want to open.

Blueprint offers the outline view for the diagram artifacts. View the full list of supported artifact types.

2. Open the outline tab in the utility panel.

1. Click the outline tab icon.

You can also point to the tab icon to view the name of the tab.

You can expand and collapse the sub-artifacts in the outline view in order to navigate the hierarchy. For example,
all Lanes in a business process diagram can be expanded to view the sub-artifacts contained within the lane.

Expanding or collapsing all artifacts in the artifact list
Blueprint provides you with the ability to quickly expand all artifacts in the artifact list as well as to collapse all
artifacts.

The Expand All and Collapse All buttons are accessible in the View tab (Artifact List group):

To expand all artifacts:

1. Right-click any column header in the main content area.
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The context menu appears.

2. Click the Expand All button.
Your artifacts and folders expand, showing all child artifacts.

To collapse all artifacts:

1. Right-click any column header in the main content area.

The context menu appears.

2. Click the Collapse All button.
Your artifacts and folders collapse, hiding all child artifacts.

About elevated trust in-browser

What is elevated trust in-browser (also known as 'elevated trust')?

To answer this question, you must first understand the kind of environment Blueprint runs in. Blueprint runs in
your web browser under Silverlight. This provides a rich, interactive application experience while at the same time
being very secure without any major client footprint. Blueprint has virtually no access to hardware and operating
system level resources unless Silverlight explicitly allows it. In This gives people peace of mind that any Silverlight
application can only operate in their own ‘sandbox’ without affecting anything outside of the application.

However, Microsoft did recognize that there are many applications that could need access to a greater set of
resources and a need to work with local applications. Therefore, they provided a safe and sanctioned way to
enable a way to run Silverlight in a more privileged mode while still running within the web browser. The full name
is ‘Elevated Trust in browser’ but we will call it ‘Elevated trust’ for the rest of this text.

What Blueprint features require 'elevated trust’?

Blueprint specifically leverages this mode for a few (optional) operations:

Screen capture: This is the built-in capability that allows the user to capture images of their windows and
drop them directly into their graphical artifacts in one click. Silverlight by default would not allow the user
to access other windows unless their privileges are elevated. Screen capture is still possible via importing an
image file saved to disk.
Pasting images: Silverlight by default revokes access to the clipboard for images, therefore any images that
may be on the user’s clipboard could not be pasted into Blueprint without additional privileges. For
example, if you had an image in your Microsoft Word document you wanted to paste into Blueprint, you
would not be able to without elevated trust.
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Rich text table integration with other applications: Because Silverlight by default revokes access to the
clipboard, the user needs the additional privileges to paste tables that are on the user's clipboard. For
example, if you have a table in your Microsoft Excel document you wanted to paste into Blueprint, you
would not be able to without elevated trust.
Visio import/export: Our integration with Visio requires direct access to the Visio application on the client
computer. Silverlight by default allows no such direct application access based on the default security
model. Therefore, privileges would need to be elevated in order to allow this access.

Is 'elevated trust' secure?

Does 'Elevated trust' open a security hole?
There is a very strict, and detailed admin-involved process required to enable elevated trust. This can be only be
done by a trusted administrator on the local client machine without any way to subvert this.

Once 'Elevated trust' is configured, has Silverlight security for the entire machine been dropped ?
Not at all. Once this is done, the client machine knows that it needs to allow an application with Blueprint’s
certificate to run in an elevated mode. This gives Blueprint additional permissions that any other Silverlight
application on the machine would NOT have.

Every Silverlight application would have to follow a similar process in order to enable them specifically. On top of
this, nobody can spoof our private Blueprint certificate and create a rogue elevated application.

Even with elevated trust, this is something we leverage sparingly. We do not go outside of the standard Silverlight
boundaries unless we absolutely need to in order to accomplish a specific task, such as Visio in/out or screen
capture. If you feel you (or a particular user) will never use these features, you do not need to run in elevated
mode at all. All other parts of Blueprint will function without issue.

How do I know if I have elevated trust in-browser enabled?

You can check whether elevated trust in-browser is enabled by opening the Profile Options screen that is located
on the application menu .
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Configuring elevated trust in-browser

Tip: This whole process has been purposely designed to be centrally managed and deployable via Group
Policy if your organization works in that manner. Refer to the Blueprint Installation Guide for more
information.

Note: If you are running Windows XP, you have two configuration options: you can follow the instructions
for configuration via the Microsoft Management Console --or-- you can install the Microsoft Windows
Server 2003 Administration Pack in order to obtain the certutil.exe program that is necessary to
configure elevated trust in-browser.

Learn more about how to determine if elevated trust in-browser is enabled.

Installation Overview
At a high level, enabling elevated trust in-browser is a two step process:

1. Inform Silverlight that a specific application will require elevation. This is achieved by adding the key
(AllowElevatedTrustAppsInBrowser with a value of DWORD:1) to the registry. This key tells
Silverlight that there is an application that will require elevated trust mode.

Note: No elevation has occurred as a result of this step. This step simply tells Silverlight to allow for
a specific application to request elevation.

2. Inform Silverlight that Blueprint (and only Blueprint) needs to run in an elevated mode. This is achieved by
installing a certificate that uniquely identifies the Blueprint application.

How to configure elevated in-trust browser

To configure Blueprint to run with elevated trust in-browser, perform the following steps on each
client:

1. Download the elevated trust in-browser configuration files.
2. Unzip the package and note the directory where the files are located.
3. Run cmd.exe as Administrator.

1. Click the Windows Start menu and type cmd.exe into the search bar.

2. Right-click the cmd.exe program that appears under the Programs heading and then select Run as
administrator:

https://na13.salesforce.com/sfc/p/30000000ny3D/a/a0000000HQQn/0dA4FEj6Jd9YZc_N8QWBi6Pot2nQNbccNynJz_pCZYo=
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3. When the confirmation dialog appears, click Yes.

The cmd.exe application launches with Administrator privileges:

4. Use the cd command to navigate to the folder where you unzipped the files.

For example:

cd c:\temp\elevated_trust

5. Enter the following commands to allow elevated trust to run on your local machine:

For 64-bit operating systems:

regedit.exe /s AllowElevatedTrustAppsInBrowser64.reg

For 32-bit operating systems:

regedit.exe /s AllowElevatedTrustAppsInBrowser.reg

6. Run the following certutil command to apply the Blueprint public certificate:

certutil.exe –f –addstore “TrustedPublisher”
publicBlueprintCertificate.cer

Here is an example of the commands run on a 64-bit operating system:
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7. Restart your web browser for the changes to take effect.

How to configure elevated in-trust browser (Windows XP users only)

1. Click the Start button and then type “mmc.exe” in the search field.

The search results appear.

2. Clickmmc.exe in the Programs list results.

A user account control dialog box appears.

3. Click Yes.

The Microsoft Management Console appears.

4. From the File menu, click Add/Remove Snap-in.

5. Select Certificates and then click the Add button.

The Certificates snap-in dialog box appears.

6. Select Computer account and then click Next.

7. Select Local computer.

8. Expand Trusted Publishers.

9. Right click Certificates > All tasks > Import.

10. Locate the file publicBlueprintCertificate.cer and place the certificate in Trusted Publishers.

Once the certificate is imported, you can see the Blueprint Software Systems certificate in Trusted Publishers.
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